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1

Inledning

Tack för att du valt Medtronic Diabetes som din partner för att underlätta för dig och dina

patienter att styra diabetesbehandlingen. Vi tror att du kan ha nytta av CareLink® Pro-

programmets banbrytande teknik och enkla,  menystyrda användargränssnitt.

Med CareLink Pro kan du ta fram, lagra och rapportera patienternas behandling och diagnostiska

uppgifter. Du kan också använda programmet för att ta fram glukosdata från pump, mätare och

sensor som dina patienter har överfört till CareLink® Personal, ett webbaserat behandlingssystem

som används tillsammans med CareLink Pro.

Funktioner

CareLink Pro är en programvara för diabetesbehandling som ska användas på en persondator.

Programmet har följande funktioner:

• Patientjournaler kan skapas för att lagra uppgifter som samlats in från en patients enhet och

även behandlingsuppgifter från patientens CareLink Personal-konto.

• Uppgifter från insulinpumpar, monitorer och blodsockermätare kan skickas till systemet,

sparas och sedan användas för att generera rapporter.

• CareLink Pro kan även samverka med CareLink Personal-systemet, så att det går att komma åt

enhetsdata som patienterna har sparat. Det är en användbar funktion om man vill ta fram

aktuella rapporter mellan patientens kontrollbesök, eller om man vill slippa läsa av uppgifter

från enheten under kontrollbesöken.

• Olika behandlingsrapporter kan skapas med de uppgifter från enheten som sparats i

patientjournalen. Rapporterna kan ge svar på frågor kring behandlingen som t.ex.

patientföljsamhet, mönster och avvikelser.

• Systemet anger automatiskt när det finns nya versioner av programvaran som kan hämtas

och installeras. På så sätt vet du säkert att du alltid har tillgång till de senaste

funktionerna.

• Hjälpfunktionen hjälper nya användare av CareLink Pro. Den kommer med tips om de

uppgifter som användaren utför.
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• Programvaran omfattar ett integrerat hjälpsystem som ger information om vissa punkter.

Säkerhet

• CareLink Pro kan skyddas med ett lösenord.

• Överföringen av patientuppgifter från CareLink Pro krypteras med tekniken Secure Sockets

Layer (SSL), som är standard inom branschen.

Relevanta dokument

Vart och ett av dessa dokument från Medtronic MiniMed har specifik information om enheten

som inte tas upp i detalj i denna bruksanvisning.

OBSERVERA: Vad gäller specifik information om mätare hänvisas till tillverkarens
bruksanvisning som medföljer mätaren.

• Bruksanvisningen till Paradigm Insulinpump

• Bruksanvisningen till Guardian REAL-Time-monitor

• Bruksanvisning till sensorfunktioner

• Bruksanvisningen till ComLink

• Bruksanvisningen till CareLink USB

Hjälp

Kontakta Medtronic-representanten i ditt land om du behöver mer hjälp med systemet. På

följande webbsida finner du internationell kontaktinformation:

http://www.minimed.com/contact/international-locations

Kompatibla enheter

CareLink Pro hämtar data från följande enheter:

OBSERVERA: Vissa enheter som stöds av denna programvara finns kanske inte tillgängliga i

alla länder där programvaran har godkänts för användning.

Insulinpumpar/glukosmonitorer

Medtronic MiniMed-pumpar: 508

Medtronic MiniMed-pumpar i Paradigm®-serien: 511, 512, 712, 515, 715, 522, 722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Guardian REAL-Time-monitorer:
CSS-7100

CSS-7100K
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Tillverkare Blodsockermätare

Länkade mätare:
• Bayer's CONTOUR® LINK

• Blodsockermätare BD Paradigm Link®

Bayer:

• CONTOUR® USB

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

BD: • Logic®

Bayer's Ascensia™ DEX™-familjen, inklusive följande
kompatibla mätare:

• Ascensia™ DEX™

• Ascensia™ DEX™ 2

• Ascensia™ DEXTER-Z® II

• Glucometer™ DEXTER-Z®

• Ascensia™ ESPRIT® 2

• Glucometer™ ESPRIT®

• Glucometer™ ESPRIT® 2

Bayer's Ascensia™ ELITE™-familjen, inklusive följande
kompatibla mätare:

• Ascensia™ ELITE™

• Glucometer™ ELITE™ XL

Abbott:

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra®

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche:

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active
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Kommunikationsenheter

CareLink® USB Används med MiniMed Paradigm-seriens insulinpump
och Guardian REAL-Time-monitor.

Blodsockermätare Paradigm Link®

Används med MiniMed Paradigm-pump och Guardian
REAL-Time-monitor. (Se bruksanvisningen till  Paradigm
Link® blodsockermätare för närmare information om
den maskinvara som krävs.)

ComLink

Används med MiniMed Paradigm-pump och Guardian
REAL-Time-monitor. (Se bruksanvisningen till  ComLink
för närmare information om den maskinvara som
krävs.)

Com-Station
Används med Medtronic MiniMed 508 pump. (Se
bruksanvisningen till  Com-Station för närmare
information om den maskinvara som krävs.)

Datakommunikationskabel

Används med blodsockermätare från andra tillverkare.
Varje mätartillverkare bifogar en
datakommunikationskabel.

Observera: Om en mätartillverkare tillhandahåller en
USB-kabel i stället för en seriell kabel för
dataöverföring måste du installera programdrivrutinen
från den tillverkaren.

Kontrollera också med tillverkaren av mätaren om
USB-drivrutinen är kompatibel med ditt
operativsystem. Vissa USB-drivrutiner kanske inte finns
tillgängliga för 64-bitars operativsystem.

Motsvarande enheter

Om du vill lägga till en enhet till systemet ska du välja märke och modell på en lista. Om

märket och modellen inte finns med på listan kan du hitta en motsvarande enhet i tabellen

nedan.

Om din patient använder någon av följande enhe‐
ter Välj den här enheten

• Bayer's Ascensia™ DEX™ 2

• Bayer's Ascensia™ DEXTER-Z™ II

• Bayer's Glucometer™ DEXTER-Z™

• Bayer's Ascensia™ ESPRIT® 2

• Bayer;s Glucometer™ ESPRIT®

• Bayer's Glucometer™ ESPRIT® 2

Bayer's Ascensia™ DEX™

Bayer's Glucometer™ ELITE™ XL Bayer's Ascensia™ ELITE™

Precision Xceed™ Optium Xceed™

Beställning

Kontakta en lokal Medtronic-representant om du vill beställa Medtronic Diabetes-produkter.

Använd följande URL för att få tillgång till internationell kontaktinformation:

http://www.medtronicdiabetes.com/help/contact/locations.html

OBSERVERA: Mätare kan beställas från deras respektive tillverkare.
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Så här använder du bruksanvisningen

OBSERVERA: I denna bruksanvisning visas exempel på skärmar. Skärmarna i den verkliga

programvaran kan avvika en aning från dessa.

I ordlistan finner du förklaringar till termer och funktioner. De skrivsätt som används i denna

bruksanvisning beskrivs i nedanstående tabell.

Term/stil Betydelse

Klicka Tryck på den vänstra musknappen över ett objekt på
skärmen för att välja objektet.

Dubbelklicka Tryck två gånger på den vänstra musknappen över ett
objekt på skärmen för att öppna objektet.

Högerklicka
Tryck på den högra musknappen över ett objekt på
skärmen för att visa ett annat fönster eller en annan
meny.

Fetstil Används för knappar, skärmar, fältnamn eller
menyalternativ. Till exempel: Patient > New Patient

OBSERVERA: 
Ger ytterligare information om ett förfarande eller
steg.

OBS!
Varnar för en möjlig risk, som, om den inte undviks,
kan leda till mindre eller medelsvåra skador på
programvaran eller utrustningen.

VARNING:

Indikerar en möjlig risk, som, om den inte undviks,
kan leda till dödsfall eller allvarlig personskada. Kan
också beskriva möjliga allvarliga biverkningar och
säkerhetsrisker.

Användarsäkerhet

Indikationer för användning

CareLink Pro-systemet är avsett att användas som ett verktyg för att underlätta

diabetesbehandling. Syftet med systemet är att omvandla information från insulinpumpar,

blodsockermätare och system med kontinuerlig blodsockerövervakning till CareLink Pro-

rapporter. Rapporterna ger information som kan användas för att identifiera trender och följa

dagliga aktiviteter, såsom antalet kolhydrater, mattider, insulindosering och blodsockervärden.

Varningar

• Systemet är avsett att användas av sjukvårdspersonal som har erfarenhet av

diabetesbehandling.

• Systemresultaten är inte avsedda att ge medicinsk rådgivning och man får inte sätta tillit till

dem i sådant syfte.

• Produkten ska endast användas tillsammans med de enheter som anges i detta dokument.

(Se Kompatibla enheter på sidan 2.)

• Patienterna ska uppmanas att kontrollera blodsockervärdet minst 4-6 gånger om dagen.
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• Patienterna ska uppmanas att inte ändra behandlingen utan att samråda med

sjukvårdspersonalen.

• Patienterna ska uppmanas att fatta beslut om behandlingen utifrån sjukvårdspersonalens

riktlinjer och resultaten av blodsockermätningar, inte utifrån glukossensorvärdena.
 
Kontraindikationer

Denna programvara får inte användas med andra enheter än de som räknas upp under

Kompatibla enheter på sidan 2.  Produkten får heller inte användas för behandling av andra

medicinska tillstånd än diabetes.

Stäng alla aktiva program på din dator innan du öppnar de här programmen:

• CGMS® System Solutions™ programvara (7310)

• Solutions® Pumps & Meters programvara (7311)

• Guardian® Solutions® programvara (7315)

• ParadigmPAL™ (7330)

• CareLink® Personal programvara (7333)

• Solutions® programvara för CGMS®iPro (7319)
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2

Förberedelser

På följande sidor beskrivs hur du startar CareLink Pro, öppnar och stänger patientjournaler och

ställer in preferenser som gäller för alla patienter i systemet.

Innan du börjar

Om det är första gången du använder CareLink Pro måste du ställa in dina allmänna preferenser

(se Allmänna preferenser på sidan 11). Dessa preferenser avgör hur vissa saker visas i

programvaran och på rapporter samt hur du vill att systemet ska kommunicera med Internet.

Preferenser kan ställas in när som helst. Det kan hända att du vill vänta tills du har bekantat dig

med CareLink Pro innan du ställer in andra preferenser.

Primära systemuppgifter

I tabellen nedan visas de huvuduppgifter som du förmodligen vill utföra första gången du ställer

in och använder CareLink Pro. Dessutom anger den var i bruksanvisningen du kan hitta

information om de olika uppgifterna.

Steg Var?

Bekanta dig med CareLink Pro-gränssnittet. Navigera inom systemet på sidan 8

Definiera de övergripande systemval som kliniken ska
använda. Ställa in systempreferenser på sidan 11

Skapa profiler för alla patienter. Lägga till  nya profiler på sidan 19

Länka till  patienternas CareLink Personal-konton. Länka till  CareLink Personal på sidan 20

Lägg till patientens pump och mätare till
patienprofilen. Lägga till  en enhet på sidan 27

Läs av data från patientens pump och mätare. Läsa av uppgifter från en enhet på sidan 33

Ställa in och generera rapporter för alla patienter. Skapa rapporter på sidan 36

Göra regelbundna säkerhetskopior av CareLink Pro-
databasen. Säkerhetskopiera databasen på sidan 46

Uppdatera CareLink Pro. Programvaruuppdateringar på sidan 45
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Navigera inom systemet

Du bör bekanta dig med användargränssnittet innan du börjar arbeta med CareLink Pro.

Användargränssnittet omfattar menyer, ett verktygsfält, ett navigationsfält, arbetsområden och

ett hjälpfönster.

Öppna CareLink Pro

1 Dubbelklicka på CareLink Pro-ikonen  på datorns skrivbord eller välj Medtronic

CareLink Pro  i programlistan i Windows startmeny.

Om kliniken kräver att du anger ett lösenord så visas inloggningsskärmen.

a. Skriv in ditt lösenord i Password-fältet (Lösenord).

OBSERVERA: Lösenordet är en tillvalsfunktion som ställs in under
installationsprocessen.

b. Klicka på LOGIN.

Startskärmen visas.

2 Klicka på New Patient  (Ny patient) om du vill starta en ny patientjournal. Om du vill öppna

en befintlig patientjournal i systemet ska du klicka på Open Patient (Öppna patient).

Arbetsområden

Om en patientrapport är öppen kan du klicka på en av knapparna i navigeringsfältet för att visa

motsvarande arbetsområde. Använd dessa arbetsområden för att mata in eller välja information

så att CareLink Pro-uppgifterna för den patienten kan utföras.

Profil: Gör att du kan spara patientinformation som
namn och födelsedatum. Det här arbetsområdet
tillåter även en länk till patientens CareLink Personal-
konto.

Enheter: Gör att du kan spara information som krävs
för att kunna avläsa en patients enheter.

Rapporter: Gör att du kan välja parametrar och
rapporter som ska genereras för patienten.

Innan en profil har lagts till  och sparats för en patient är det bara arbetsområdet Profile (Profil)

som är tillgängligt för den patienten. Innan enheter har lagts till för en patient är det bara

arbetsområdena Profile (Profil) och Devices (Enheter) som är tillgängliga för den patienten.

Verktygsfält

CareLink Pro-verktygsfältet ger snabb åtkomst till funktioner som används ofta. Följande knappar

finns i verktygsfältet.
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Knapp Namn Funktion

Lägg till patient

Öppnar ett arbetsområde för
Profile (Profil) så att du kan lägga
till en ny patientjournal till
systemet.

Öppna patient

Öppnar tabellen Patient Lookup
(Patientsökning) där du kan välja
vilken befintlig patientjournal du
vill visa.

Hjälp

Visar eller döljer hjälpfönstret.
Klicka för systemhjälp som tar
hänsyn till  var du befinner dig i
systemet.

Patientflikar

Efter att du har öppnat en patientjournal visas en flik bredvid verktygsfältet med patientens

namn. När en flik är aktiv innebär det att en patients journal och arbetsområde är aktiva och att

du kan utföra CareLink Pro-uppgifter för patienten.

Om du vill göra en patients journal aktiv så att du kan arbeta med den klickar du på fliken för

denna patient. När du vill stänga journalen klickar du på Stäng-knappen  på fliken.

Hjälpfunktionen

Det finns en hjälpfunktion i hela CareLink Pro. Den öppnar ett fönster med hjälp och tips om

handlingar som kan utföras i den del av systemet som är aktivt. Hjälpfönstren kan även ha länkar

till >>learn more (läs mer). Om du klickar på dem tar länkarna dig till det relevanta avsnittet i

onlinehjälpen för mer information. Standardinställningen är att hjälpfunktionen är aktiverad. Det

går dock att stänga av den när som helst.

Slå av och på hjälpfunktionen

Du kan slå på/av hjälpfunktionen genom att göra något av det följande:
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• Klicka på knappen Guide Me  (Hjälp). 

• Välj Help > Guide Me.

Öppna patientjournaler

Upp till sex patientjournaler kan öppnas samtidigt. Se Lägga till  nya profiler på sidan 19  om

du inte har skapat några patientprofiler ännu.

1 Välj File > Open Patient (Fil > Öppna patient) eller klicka på knappen Open Patient (Öppna

patient).  En patientlista liknande den följande visas.

OBSERVERA: Om du får ett meddelande om att alltför många patientjournaler är öppna
ska du klicka på OK, stänga en journal och sedan fortsätta.

2 Sök efter en patient genom att skriva in hela eller delar av patientens namn i fältet Find a

Patient  (Sök patient). När den patient du sökte markeras ska du klicka på knappen OPEN
(ÖPPNA), dubbelklicka på raden eller trycka på ENTER. Du kan även navigera igenom listan

med piltangenterna upp och ned på tangentbordet.

Patientens arbetsområde Devices (Enheter) (om inga enheter har lagts till än) eller Reports

(Rapporter) visas.

3 Klicka på knappen Profile  i navigationsfältet om du vill se arbetsområdet för

patientens Profil.

Stänga patientjournaler

1 Kontrollera att den patientjournal du vill stänga är aktiv (fliken är markerad).

2 Gör något av följande:
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a. Välj File > Close Patient  (Fil > Stäng patient).

b. Klicka på Stäng-knappen  på patientens flik.

c. Tryck på Ctrl + F4.

Ställa in systempreferenser

Dessa preferenser gäller för alla patienter i systemet. Se Bekräfta rapportinställningarna på

sidan 39  för sådana preferenser som endast gäller enskilda patienter.

Preferenserna visas i följande grupper:

• General (Allmänt)

- Blodsockerenheter

- Kolhydratenheter

- Kommunikation

- Felsökning

• Patient Profile (Patientprofil)

- Välj och arrangera datafälten i patientprofiler.

• Patient Lookup (Patientsökning)

- Anpassa och ändra ordningen på de fält som visas då du väljer Open Patient (Öppna

patient) för att ta fram en lista med patienter.

• Report Generation (Generera rapporter)

- Välj vilka datafält du vill visa då du i datatabellen väljer vad som ska ingå i Daily Detail

(Daglig detalj)-rapporten.

Allmänna preferenser

Använd fliken General (Allmänt) för att definiera hur programmet ska visa olika typer av

information och för att göra önskade inställningar för extern kommunikation.

1 Klicka på fliken General (Allmänt) om den inte redan är aktiv.

2 Välj Tools > Options  (Verktyg > Alternativ). Följande fönster visas.
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3 Klicka på knappen för att välja det värde du vill ha:

- Glucose Units (Glukosenheter):  mmol/l eller mg/dl

- Carbohydrate Units (Kolhydratenheter):  gram eller utbyten

a. Om du väljer Exchanges (Utbyten) för Carbohydrate Units  (Kolhydratenheter) ska du

skriva in motsvarande siffra i fältet grams are equal to 1 Exchange  (gram motsvarar 1

utbyte).

4 Markera eller avmarkera rutan i avsnittet Chart Options > Overview Report (Diagramalternativ

> Översiktsrapport). Om rutan är markerad kommer programmet att binda samman BS-

värdena i diagrammet Meter Glucose Overlay med linjer. (Det här diagrammet visas i

översiktsrapporten för sensorer och mätare.)

5 Markera rutan (aktivera) eller avmarkera rutan (inaktivera) för följande

kommunikationspreferenser:

OBSERVERA: Se till att du följer klinikens eller dataavdelningens riktlinjer då du ställer

in kommunikationspreferenserna.

- Automatically check for software updates (Sök automatiskt efter
programuppdateringar):  Om detta har valts skickas ett meddelande till alla aktiva

system som använder CareLink Pro så snart det finns en uppdatering av programvmet.

Användaren har då möjligheten att hämta och installera uppdateringarna. Om du

föredrar en kontrollerad distribution av uppdateringar ska denna ruta avmarkeras.

- Synchronize with Medtronic CareLink® Personal (Synkronisera med Medtronic
CareLink® Personal):  Markera denna ruta om du vill att systemet automatiskt

synkroniserar dina patienters CareLink Personal-uppgifter varje gång du öppnar deras

profiler. Om denna ruta avmarkeras måste du manuellt synkronisera CareLink Personal-

uppgifterna för varje patient.

6 Markera eller avmarkera rutan i avsnittet Troubleshooting (Felsökning). Om rutan är

markerad kommer programmet att spara en rapport med avläsningar av enheten för

felsökning.
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7 Klicka på OK för att spara de allmänna preferenserna.

Preferenser för patientprofiler

Det här är en övergripande inställning som definierar profilernas innehåll.  Du kan anpassa fälten i

arbetsområdet Profiles (Profiler) för att de ska innehålla den information som är mest relevant för

kliniken. Du kan lägga till eller ta bort fält, skapa dina egna anpassade fält och bestämma fältens

visningsordning i fönstret.

1 Välj Tools > Options  (Verktyg > Alternativ).

2 Klicka på fliken Patient Profile  (Patientprofil). Följande fönster visas.

OBSERVERA: Markera rutorna för de fält du vill ha med i profilen. Använd upp- och

nedpilarna för att lägga fälten i rätt ordningsföljd.

Välja datafält

1 Markera rutorna för att lägga till de fält du vill ha.

OBSERVERA: Förnamn och efternamn kan inte tas bort.

2 Avmarkera rutan om du vill ta bort ett fält från profilen.

3 Om fältet ska vara obligatoriskt ska rutan i kolumnen Required  (Obligatoriskt) markeras. Alla

fält som är obligatoriska måste fyllas i innan det går att skapa en profil.

Lägga till ett anpassat fält

1 Markera rutan till vänster om ett tomt anpassat fält.

2 Skriv in text så att fältet får ett namn (t.ex. Kontaktperson i nödlägen). Det fältnamnet

kommer att visas på patientprofilen.

3 Om fältet ska vara obligatoriskt ska rutan i kolumnen Required  (Obligatoriskt) markeras.
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OBSERVERA: Om du vill ta bort ett anpassat fält från profilen ska du avmarkera rutan
bredvid de(t) fält du vill ta bort.

Ändra ordningen på datafälten

Välj det fält du vill flytta och klicka på upp- eller nedpilen  för att flytta det. (Pilen överst och

nederst flyttar fältet till den översta eller understa positionen på listan.)

Slutföra preferenserna för patientprofiler

Klicka på OK  när du har fått med alla fält du vill ha, i rätt ordning.

Nu har patientprofilerna alla fält, i den ordning, som du valt.

Preferenser för patientsökning

Tabellen Patient Lookup (Patientsökning) används för att söka och öppna patientjournaler.

Denna tabell omfattar alla patienter i databasen och med hjälp av den kan man hämta

identifieringsuppgifter från patientprofilerna. Du kan anpassa informationen som visas i denna

tabell och den ordning i vilken kolumnerna visas. Gör så här för att anpassa tabellen Patient

Lookup (Patientsökning):

1 Välj Tools > Options  (Verktyg > Alternativ).

2 Klicka på fliken Patient Lookup  (Patientsökning). Följande fönster visas.

OBSERVERA: Markera rutorna för att välja de uppgifter du vill ha med i tabellen Patient
Lookup (Patientsökning). Använd upp- och nedpilarna för att lägga kolumnerna i rätt
ordningsföljd.
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Välja vilka uppgifter ska visas

Markera i rutorna för att välja vilka uppgifter du vill visa, eller avmarkera rutorna för uppgifter du

inte vill visa i tabellen Patient Lookup (Patientsökning).

Ändra kolumnernas ordningsföljd

Om du vill ändra ordningsföljden på kolumnerna i tabellen Patient Lookup (Patientsökning) ska

du välja den kolumn som ska flyttas och klicka på upp- eller nedpilarna.  (Pilarna överst och

nederst flyttar kolumnen till den översta eller understa positionen på listan.)

Den kolumn som står överst på listan Column Display Order (Visningsordning för kolumner)

kommer att visas som första kolumn i tabellen Patient Lookup (Patientsökning). Den kolumn som

står nederst kommer att visas som sista kolumn i tabellen.

Slutföra preferenserna för patientsökning

Klicka på OK  när du har fått med alla kolumner du vill ha, i rätt ordning.

Tabellen Patient Lookup (Patientsökning) har nu uppgifterna och kolumnerna i den ordning du

valt.

Preferenser för rapportgenerering

Datatabellen visas i fönstret Select and Generate Reports (Välj och generera rapporter). Den

här tabellen används vid rapportering. Den innehåller dagliga uppgifter hämtade från

patienternas enheter och, om tillämpligt, deras CareLink Personal-konton. Med hjälp av

uppgifterna som visas i denna tabell kan du bestämma vilka dagar du vill ha en Daily Detail

(Daglig detalj)-rapport över. Du kan även välja vilka andra rapporter du vill generera.

Kliniken kan anpassa uppgifterna som visas i tabellen, inklusive ordningen i vilken de visas, så

att tabellen endast innehåller den information som är mest relevant för klinikens verksamhet.

OBSERVERA: Mer information om hur dessa preferenser påverkar datatabellen när

rapporten skapas finns i Välja rapporttyper och datum som ska omfattas på sidan 40.

1 Välj Tools > Options  (Verktyg > Alternativ).
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2 Klicka på fliken Report Generation  (Rapportgenerering). Följande fönster visas.

Välja vilka uppgifter ska visas

Markera rutorna för att välja vilka uppgifter du vill visa, eller avmarkera rutorna för uppgifter du

inte vill visa i datatabellen.

Följande uppgifter kan inkluderas i datatabellen.

Kolumnrubrik Definition

№ of Meter Readings (Antal mätaravläsningar) Antal avläsningar vid det angivna datumet som
registrerats av enheterna.

Meter Readings Average (Mätaravläsningar,
genomsnitt)

De genomsnittliga blodsockervärdena som registrerats
av enheterna.

Sensor Duration (Sensorvaraktighet)
Tidsperioden inom det angivna datumet för vilken
sensoruppgifter registrerats. Värdena är -- (inget), 0:05
- 24:00.

Sensor Average (Sensor, genomsnitt) De genomsnittliga sensoravläsningarna som
registrerades vid det angivna datumet.

Highest Reading (Högsta avläsning) Det högsta blodsockervärdet (från en sensor eller
mätare) vid det angivna datumet.

Lowest Reading (Lägsta avläsning) Det lägsta blodsockervärdet (från en sensor eller
mätare) vid det angivna datumet.

Avg AUC Below Target (Genomsnittl.  AUK under mål) Den genomsnittliga arean under kurvan ligger under
patientens målområde.

Avg AUC Above Target (Genomsnittl. AUK över mål) Den genomsnittliga arean under kurvan ligger över
patientens målområde.

Total Carbs (Summa kolhydrater)

Summan av alla kolhydratmängder (avrundad till
närmaste gram eller närmaste 0,1 utbyte, beroende på
den måttenhet som används) rapporterad under
dagen via Bolusguidehändelser eller kolhydratmarkörer
på pumpen eller Guardian-monitor.
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Kolumnrubrik Definition

Suspend Duration (Varaktighet för stopp)
Den tid under vilken pumpen stoppades vid det
angivna datumet. Värdena är -- (inga data), 00:01 -
24:00.

№ of Rewinds (Antal återställningar) Antal återställningshändelser vid det angivna datumet.

№ of Primes (or Fills) (Antal primes (eller påfyllningar)) Antal primehändelser (eller påfyllningshändelser) som
registrerats vid det angivna datumet.

Prime (or Fill) Volume (U) (Volym för primes eller
påfyllningar)

Sammanlagd volym insulin som använts för
primehändelser (eller påfyllningshändelser) vid det
angivna datumet.

Total Insulin (U) (Summa insulin) Sammanlagd volym insulin som getts vid det angivna
datumet, registrerad av pumpen.

Total Basal (U) (Summa basal)
Sammanlagd volym basalinsulin som getts vid det
angivna datumet (total mängd insulin som getts,
minus summan av alla bolusar som getts).

Total Bolus (U) (Summa bolusar) Sammanlagd volym insulin som getts i bolusar vid det
angivna datumet, registrerad av pumpen.

Basal % Visar förhållandet (i hela procentvärden) mellan
basalinsulin och total mängd insulin.

Bolus % Visar förhållandet (i hela procentvärden) mellan
bolusinsulin och total mängd insulin.

№ of Boluses (Antal bolusar) Antal bolushändelser som registrerats vid det angivna
datumet.

Bolus Wizard Events (Bolusguidehändelser) Det totala antalet bolusguidehändelser som
registrerats vid det angivna datumet.

Bolus Wizard Overrides (Bolusguide, avvikelser) Antal bolusguidehändelser i vilka mängden doserad
insulin skiljer sig från den rekommenderade mängden.

№ of Meal Boluses (Antal måltidsbolusar) Antal bolusguidehändelser med kolhydratmängder
över noll som registrerades vid det angivna datumet.

№ of Correction Boluses (Antal korrektionsbolusar) Antal bolusguidehändelser med korrektionsmängder
över noll som registrerades vid det angivna datumet.

№ of Manual Boluses (Antal manuella bolusar)
Antal bolushändelser som registrerades vid det
angivna datumet och som inte var
bolusguidehändelser.

Ändra kolumnernas ordningsföljd

Om du vill ändra ordningsföljden på kolumnerna i datatabellen ska du välja den kolumn som ska

flyttas och klicka på upp- eller nedpilarna.  (Pilarna överst och nederst flyttar kolumnen till

den översta eller understa positionen på listan.)

OBSERVERA: Punkter som står överst på listan Column Order (Kolumnordning) kommer att
visas som första kolumn i datatabellen. Punkter som står nederst kommer att visas som
sista kolumn i datatabellen.

Slutföra preferenserna för rapportgenerering

Klicka på OK  när du har fått med alla kolumner du vill ha, i rätt ordning.

Datatabellen har nu uppgifterna och kolumnerna i den ordning du valt.
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3

Arbetsområdet Profile (Profil)

En profil motsvarar framsidan på en journal. Den innehåller patientuppgifter som namn och

födelsedatum. En profil krävs innan uppgifter kan samlas in från enheten och användas för

rapporter om behandlingen.

Arbetsområdet Profile (Profil) gör det även möjligt att lägga in en länk till patientens CareLink

Personal-konto. Efter att länken har lagts in kan du när som helst hämta patientuppgifter som

sparats i CareLink Personal — utan att patienten behöver vara där.

Innan du börjar

Det kan hända att du vill anpassa patientprofilerna så att de bara innehåller den typ av

information som du vill samla in. Läs mer om detta under Preferenser för patientprofiler på

sidan 13.
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Det krävs ett användarnamn och ett lösenord för att kunna lägga in en länk till patientens

CareLink Personal-konto. Patienten måste vara närvarande för att tillhandahålla dessa

uppgifter.

Lägga till nya profiler

Varje gång du vill lägga till en patient till CareLink Pro-systemet måste du börja med att fylla i en

profil för patienten.

1 Välj File > New Patient (Fil > Ny patient) eller klicka på knappen Add Patient  (Lägg till

patient). 

Arbetsområdet Profile  (Profil) visas.

OBSERVERA: Klicka på Customize fields (Anpassa fält) för att lägga till eller ändra fält i
patientprofilen. Se Preferenser för patientprofiler på sidan 13.

2 Fyll i fälten i avsnittet Patient Profile.

3 Klicka på SAVE (SPARA).

Den nya patientprofilen läggs till i CareLink Pro-databasen. Ett bekräftelsemeddelande om att

profilen har sparats visas.

Fyll i de obligatoriska fälten

1 Om ett obligatoriskt fält inte har fyllts i då patientprofilen sparas visas ett meddelande

bredvid det fältet. Det går inte att spara profilen innan det fältet har fyllts i.

2 Fyll i fältet.

3 Klicka på SAVE (SPARA).

4 Klicka på OK när bekräftelsemeddelandet visas.

Redigera patientprofiler

1 Kontrollera att patientens arbetsområde Profile  (Profil) är öppet.

2 Klicka på EDIT  (REDIGERA).

3 Redigera de uppgifter som ska ändras i avsnittet Patient Profile.

4 Klicka på SAVE (SPARA).

Ett bekräftelsemeddelande om att profilen har sparats visas.

Radera patientuppgifter ur systemet

1 Kontrollera att patientens arbetsområde Profile  (Profil) är öppet.

2 Kontrollera att det är just den patienten du vill radera. Om en patientprofil raderas innebär

det också att alla uppgifter i CareLink Pro-databasen raderas och det kan inte ångras.
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3 Klicka på >> delete patient record (radera patientjournal) ovanför synkroniseringsavsnittet

på profilen.

Ett meddelande visas som varnar dig om att alla patientuppgifter kommer att raderas när du

tar bort journalen.

4 Klicka på Yes (Ja) för att ta bort patientjournalen.

Länka till CareLink Personal

Om patienten tillåter det kan du lägga in en länk till patientens CareLink Personal-konto. Detta

webbaserade verktyg gör det möjligt för patienterna att skicka och spara uppgifter som hämtats

från deras enheter samt köra olika behandlingsrapporter.

Efter att du har länkat till patientens CareLink Personal-konto kan du hämta de uppgifter från

enheten som sparats där. Detta är praktiskt om du vill skapa CareLink Pro-behandlingsrapporter

mellan patientens kontrollbesök. Dessutom innebär det att enheten sällan eller aldrig behöver

avläsas under patientens kontrollbesök.

Om en patient inte har något CareLink Personal-konto kan du mejla patienten och uppmana

honom eller henne att skapa ett.

Länka till ett befintligt konto

OBSERVERA: Patienten måste vara närvarande för att dessa steg ska kunna slutföras.

1 Kontrollera att du har Internetanslutning.

2 Öppna patientens arbetsområde Profile  (Profil).

3 Kontrollera att alla obligatoriska fält i avsnittet Patient Profile  (Patientprofil) är ifyllda.

4 Klicka på LINK TO EXISTING ACCOUNT (LÄNKA TILL BEFINTLIGT KONTO).

CareLink Personal-inloggningsskärmen visas.

5 Be patienten att:

a. Skriva in sitt användarnamn och lösenord.

b. Klicka på Sign In (Logga in).

Sidan Grant Access (Bevilja åtkomst) visas, baserad på patientens registreringsinställningar

för språk och region.

6 Be patienten att:

a. Läsa igenom Terms of Use  (användarvillkoren).

b. Klicka på rutan bredvid I agree to the Terms of Use above... (Jag accepterar villkoren

ovan).

c. Klicka på Grant Access (Bevilja åtkomst).

d. Tala om för dig när sidan Thank You  (Tack) visas.

7 Vid behov kan du skriva ut användarvillkoren åt patienten genom att klicka på knappen Print
(Skriv ut). Nu har du en länk till den här patientens CareLink Personal-konto.
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Mejla en inbjudan

Gör så här för att mejla en inbjudan till en patient om att öppna ett CareLink Personal-konto:

1 Öppna patientens arbetsområde Profile  (Profil).

2 Kontrollera att alla obligatoriska fält i avsnittet Patient Profile  (Patientprofil) är ifyllda.

3 Klicka på SEND E-MAIL INVITATION TO PATIENT (MEJLA INBJUDAN TILL EN PATIENT).

4 Kontrollera att Patient Name (Patientnamn), Email Address  (e-postadress) och Language
(Språk) har fyllts i korrekt.

5 Klicka på SEND (SKICKA).

I patientens profilstatusområde bekräftas att mejlet har skickats.

Hämta uppgifter från ett länkat konto

Om du har länkat till en patients CareLink Personal-konto kommer alla nya uppgifter från

detta konto att skickas automatiskt varje gång du öppnar patientprofilen i CareLink Pro.

OBSERVERA: För att säkerställa att detta sker ska du gå till Tools > Options > General

(Verktyg > Alternativ > Allmänt) och kontrollera att rutan bredvid ”Synchronize with
CareLink Personal” (Synkronisera med CareLink Personal) är markerad.

Följ dessa steg för att hämta CareLink Personal-uppgifterna när som helst efter att du har

öppnat patientprofilen:

1 Kontrollera att patientens arbetsområde Profile  (Profil) är öppet och att du är ansluten till

Internet.

2 Välj Tools > Synchronize Patient Data  (Verktyg > Synkronisera patientuppgifter).

Synkroniseringsikonen  på patientfliken roterar. Då ikonen stannar har processen

slutförts.

OBSERVERA: Om patienten inte längre vill dela sina CareLink Personal-uppgifter visas
ett meddelande som informerar dig om detta.
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3 Alla ytterligare uppgifter som hämtats från CareLink Personal visas i patientrapporterna.

Koppla bort en patients CareLink Personal-konto från CareLink Pro

Du kan koppla bort en patients CareLink Personal-konto från CareLink Pro. Detta är endast

möjligt efter att en patient har blivit länkad. CareLink Pro kan därefter inte längre samla in

data från patientens CareLink Personal-konto. Det påverkar inte patientens egen användning

av CareLink Personal-kontot.

1 Öppna patientjournalen och gå till arbetsområdet Profile  (profil).

2 Klicka på UNLINK ACCOUNT (TA BORT LÄNK TILL KONTO).

3 Klicka på Yes (Ja) för att bekräfta. Patientens profil är inte längre länkad till  CareLink Pro.

Statusen ändras till  Not linked (Inte länkad) och knapparna LINK TO EXISTING ACCOUNT
(LÄNKA TILL BEFINTLIGT KONTO) och SEND E-MAIL INVITATION TO PATIENT (MEJLA

INBJUDAN TILL PATIENT) visas nu.

CareLink Pro Användarhandbok   Arbetsområdet Profile (Profil) 22



4

Maskinvaruinställning

För att kunna läsa av uppgifter direkt från en enhet måste du ha tillgång till patientens enhet och

ha de kablar eller kommunikationsenheter som krävs för att överföra data till din dator.

Om patienten har överfört uppgifterna från sin enhet till sitt CareLink Personal-konto kan du även

komma åt uppgifterna genom att länka till detta konto. Se Länka till CareLink Personal på sidan 20

för information om hur du länkar till  en patients CareLink Personal-konto.

Ansluta enheter

Granska översiktsdiagrammet för att få en allmän uppfattning om hur enheter ska ställas in för att

kunna kommunicera med datorn. Följande diagram illustrerar specifika aspekter av enhetens

kommunikation.

Mer information finns i de instruktioner som CareLink Pro visar då du läser av enheter.
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Översikt över maskinvaruinställningar

Det här exemplet visar hur CareLink USB används för kommunikation mellan pumpen och datorn.

Se Kompatibla enheter på sidan 2 för en lista över vilka kommunikationsenheter som stöds.

Exempel på anslutning med seriell kabel respektive USB-kabel:
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Valfri ComLink för användning med pump i Paradigm-serien:

Valfri Com-Station för användning med Medtronic MiniMed 508 pump:
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5

Arbetsområdet Devices (Enheter)

Information som du behöver för att kunna läsa av en patients enhet, t.ex. märke, modell och

serienummer, sparas i arbetsområdet Devices (Enheter). Den behöver alltså inte anges varje gång

du läser av uppgifter från enheten.

Enheter i arbetsområdet Devices (Enheter) sparas på en av två listor: Active Devices (Aktiva

enheter) eller Inactive Devices (Inaktiva enheter). När du lägger till en enhet hamnar den

automatiskt på listan Active Devices (Aktiva enheter). Du kan bara läsa av uppgifter från enheter

som visas på listan Active Devices (Aktiva enheter). De är sannolikt de enheter som din patient

använder.

Andra enheter som patienten kan ha, men som han eller hon inte använder just nu, kan sparas på

listan Inactive Devices (Inaktiva enheter). Det gör att informationen sparas och att dessa enheter

kan aktiveras när det behövs.
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Innan du börjar

Innan du kan öppna arbetsområdet Devices (Enheter) för en patient måste han eller hon ha en

profil som sparats i systemet. Se Lägga till  nya profiler på sidan 19.

För att du ska kunna lägga till en enhet eller läsa uppgifter direkt från den måste den

kommunicera med datorn. I Ansluta enheter på sidan 23  beskrivs hur du ställer in enheter så att de

kan kommunicera med datorn.

Lägga till en enhet

Du kan hämta uppgifter från en patients CareLink Personal-konto för en enhet som inte lagts till

ännu. Sådana enheter läggs automatiskt till när uppgifter synkroniseras mellan CareLink Personal

och CareLink Pro.

OBSERVERA: Det kan bara finnas en aktiv pump per patient. Om du lägger till en ny pump
flyttas den tidigare till den inaktiva listan.

Lägga till en Medtronic-pump eller Guardian-monitor

1 Kontrollera att den enhet du lägger till är inställd så att den kan kommunicera med datorn.

(Se Ansluta enheter på sidan 23  för de olika anslutningsstegen.)

2 Klicka på patientfliken eller dubbelklicka på patientens namn i tabellen Patient Lookup

(Patientsökning).

3 Klicka på Devices  (Enheter) för att öppna patientens arbetsområde för enheterna.

4 Klicka på ADD DEVICE  (LÄGG TILL ENHET).

5 Välj Medtronic Pump/Guardian.  Guiden Add Medtronic Pump/Guardian  (Lägg till

Medtronic Pump/Guardian) visas.

OBSERVERA: Pumpmodellen anges på pumpens baksida eller på pumpstatusskärmen.

6 Klicka på knappen som avser den enhet du vill lägga till.
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Om du har valt alternativet MiniMed 508 pump ska du gå du vidare till steg 9.

7 Klicka på NEXT  (NÄSTA). Sidan Serial Number  (Serienummer) visas.

OBSERVERA: Ett felmeddelande visas om du anger fel serienummer. Titta på exemplen
på den här sidan och kontrollera att du har angivit samma uppgifter som på pumpens
baksida. Skriv in de sex tecknen på nytt om det behövs.

8 Använd exemplen på den här sidan för att hitta serienumret (bestående av sex tecken) på

den enhet du ska lägga till. (Om du behöver mer hjälp för att hitta numret kan du klicka på

>>learn more (mer information).) Skriv in de sex tecknen i fältet Device Serial Number
(Enhetens serienummer).

9 Klicka på NEXT  (NÄSTA). Sidan med Communication Options  (Kommunikationsalternativ)

som ser ut som den följande visas.

10 Klicka på nedrullningsmenyn Choose Port  (Välj port) och välj den port som ComLink,

Paradigm Link®, CareLink USB eller Com-Station ansluts till på din dator. Om du inte är säker

på vilken port som är den rätta väljer du Auto Detect (or USB) (Automatisk identifiering

(eller USB)).
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11 Klicka på NEXT  (NÄSTA). Sidan Test Connection  (Testa anslutningen) som ser ut som den

följande visas.

12 Följ enhetens instruktioner och klicka på TEST.

Ett meddelande visas som anger om anslutningen lyckades eller inte. Om den lyckades ska

du gå vidare till nästa steg.

OBSERVERA: Det här testet läser inte av några pumpuppgifter utan bekräftar bara att

kommunikationen mellan pumpen och datorn fungerar.

Om den inte fungerar ska du kontrollera att enheten och datorn har anslutits på rätt sätt.

Klicka även på BACK  (TILLBAKA) på sidorna i guiden för att kontrollera att de uppgifter som

du angett om enheten är riktiga.

13 Klicka på DONE (KLAR).

Enheten har lagts till patientens lista Active Devices (Aktiva enheter).

Lägga till en mätare

1 Klicka på patientfliken eller dubbelklicka på patientens namn i tabellen Patient Lookup

(Patientsökning).

2 Kontrollera att den mätare du lägger till kommunicerar med datorn. (Se Ansluta enheter på

sidan 23 för de olika anslutningsstegen.)

3 Klicka på knappen Devices  (Enheter) för att öppna arbetsområdet Devices för patienten.

4 Klicka på knappen ADD DEVICE  (LÄGG TILL ENHET).
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5 Välj Blood Glucose Meter (Blodsockermätare). Guiden Add Blood Glucose Meter  (Lägg till

blodsockermätare) visas.

6 Klicka på alternativknappen för att ange märket på mätaren.

7 Klicka på NEXT  (NÄSTA). Sidan Meter Model  (Mätarmodell) visas (denna sida ser olika ut

beroende på mätarens tillverkare).

8 Klicka för att välja den mätarmodell som du lägger till.

9 Klicka på NEXT  (NÄSTA). Sidan Communication Options  (Kommunikationsalternativ) visas.
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OBSERVERA: Det går bara att välja de alternativ som är giltiga för den mätare du
lägger till.

10 Klicka på nedrullningsmenyn Choose Port  (Välj port) och välj den port som ComLink,

Paradigm Link eller CareLink USB ansluts till på din dator. Om du inte är säker på vilken port

som är den rätta väljer du Auto Detect (or USB) (Automatisk identifiering (eller USB)).

11 Klicka på NEXT  (NÄSTA). Sidan Test Connection  (Testa anslutningen) visas.

12 Följ mätarens instruktioner och klicka på TEST.

Om du lägger till en Bayer's CONTOUR® USB-mätare ska du se till att Bayer's GLUCOFACTS®-

programmet är avstängt. Kontrollera i Windows systemfältet, som visas här. Om du ser

GLUCOFACTS-ikonen högerklickar du på den och väljer Exit  (Avsluta).

Ett meddelande visas som anger om anslutningen lyckades eller inte. Om den lyckades ska

du gå vidare till nästa steg.

Om den inte fungerar ska du kontrollera att enheten och datorn har anslutits på rätt sätt.

Klicka även på BACK (TILLBAKA) i guiden för att kontrollera att de uppgifter som du angett är

riktiga.

13 Klicka på DONE (KLAR).

Mätaren har lagts till patientens lista Active Devices (Aktiva enheter).

Aktivera eller inaktivera en enhet

Patientenheterna kan flyttas mellan listorna Active Devices (Aktiva enheter) och Inactive Devices

(Inaktiva enheter) efter behov. En enhet måste vara aktiv för att man ska kunna läsa av uppgifter

från den.

Du kan ha så många mätare du vill på listan Active Devices (Aktiva enheter), men bara en pump.

Kontrollera att du verkligen vill inaktivera den aktuella pumpen innan du lägger till en ny.
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Inaktivera en enhet

1 Klicka på patientfliken eller dubbelklicka på patientens namn i tabellen Patient Lookup

(Patientsökning).

2 Klicka på knappen Devices  (Enheter) för att öppna arbetsområdet Devices för patienten.

Enheterna kan finnas med på listan med ett motsvarande namn. Se Kompatibla enheter på

sidan 2.

3 Klicka på >> make this device inactive  (inaktivera den här enheten) under den enhet du vill

inaktivera. Enheten flyttas till listan med Inactive Devices  (Inaktiva enheter).

Återaktivera en enhet

1 Klicka på patientfliken eller dubbelklicka på patientens namn i tabellen Patient Lookup

(Patientsökning).

2 Klicka på knappen Devices  (Enheter). Patientens arbetsområde Devices  (Enheter) visas.

Enheterna kan finnas med på listan under ett motsvarande namn. Se Kompatibla enheter på

sidan 2.

3 Klicka på >> activate this device  (aktivera den här enheten) under den enhet du vill

aktivera.

Enheten flyttas till listan Active Devices (Aktiva enheter).

Radera en enhet

Gör så här för att radera en enhet och dess uppgifter från arbetsområdet Devices (Enheter)

och CareLink Pro-systemet:

1 Klicka på patientfliken eller dubbelklicka på patientens namn i tabellen Patient Lookup

(Patientsökning).

2 Klicka på knappen Devices  (Enheter) för att öppna arbetsområdet Devices för patienten.

Enheterna kan finnas med på listan under ett motsvarande namn. Se Kompatibla enheter på

sidan 2.

3 Kontrollera att enheten finns med på listan Inactive Devices (Inaktiva enheter). Om den inte

gör det ska du klicka på >> Inactivate this device  (Inaktivera denna enhet) på den lista där

den står nu.

4 Klicka på >> delete this device  (radera den här enheten) under den enhet du vill radera. Ett

meddelande visas som varnar dig om att enheten och alla dess uppgifter kommer att raderas

från patientens journal.

5 Klicka på YES  (JA) för att radera enheten.

Enheten och dess uppgifter tas bort från arbetsområdet Devices  (Enheter) och från CareLink

Pro-systemet. Uppgifter från den här enheten kan inte längre användas i rapporter.
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Läsa av uppgifter från en enhet

Ett sätt att få uppgifter från en enhet är att länka till patientens befintliga CareLink Personal-

konto. (Se Länka till CareLink Personal på sidan 20.) Ett annat sätt är att läsa av dem direkt från

enheten, på det sätt som beskrivs här.

Uppgifter från patientens enhet kan läsas av CareLink Pro om enheten finns med på listan Active

Devices (Aktiva enheter) och om den kommunicerar med datorn. Efter att du har fått fram de här

uppgifterna kan du använda dem för att skapa rapporter som underlättar bedömningen av

patientens behandling. Se Om rapporter på sidan 42  för en kort beskrivning av de tillgängliga

rapporterna.

CareLink Pro kan samla in följande uppgifter från en insulinpump:

• Olika pumpinställningar såsom alarmtyp, signalvolym och tid

• Tillförda basaldoser insulin

• Bolushändelser och tillförda mängder

• Information från Bolusguiden

• Primingmängder

• Stopperioder

• Sensorglukosvärden under en tidsperiod, på pumpar med sensorfunktioner
 
Systemet kan också samla in följande data från ett Guardian REAL-Time-system:

• Sensorglukosvärden (SG)

• Sensorkoefficientvärden 

• Sensorkalibreringsfaktorer 

• Måltidsmarkörer 

• Insulininjektioner
 
Dessutom kan olika typer av information som lagrats i en blodsockermätare överföras till

systemet under avläsning av enheten.

VARNING: Avbryt eller slutför alla temporära basaldoser eller aktiva bolusar och radera alla
aktiva alarm. Pumpen stoppas under avläsningen. Kontrollera att pumpen startar igen när
avläsningen är klar.

OBS! Använd inte fjärrkontrollen då pumpen avläses. Om pumpbatteriet nästan är tomt
skickar pumpen inte några uppgifter till datorn. Byt ut batteriet om statusen anger att

batteriet är nästan tomt.

1 Klicka på patientfliken eller dubbelklicka på patientens namn i tabellen Patient Lookup

(Patientsökning).

2 Kontrollera att patientens enhet kommunicerar med datorn. (Se Ansluta enheter på sidan 

23.)

3 Klicka på knappen Devices  (Enheter) för att öppna arbetsområdet Devices för patienten.
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Enheterna kan finnas med på listan under ett motsvarande namn. Se Kompatibla enheter på

sidan 2.

4 Lokalisera den enhet du vill hämta uppgifter från i listan Active Devices  (Aktiva enheter), och

se till att uppgifterna under Choose port (Välj port) är korrekta.

För pumpar klickar du på nedrullningsmenyn Amount of Data  (Antal uppgifter) och väljer

den mängd uppgifter du vill att CareLink Pro ska läsa av.

5 Klicka på motsvarande knapp READ DEVICE  (LÄS AV ENHET).

6 Följ specifika instruktioner för enheten och klicka på OK.

7 CareLink Pro visar en förloppsindikator som visar hur stor del av avläsningen som har

slutförts.

Om du klickar på CANCEL (AVBRYT) under avläsningen av enheten visas ett meddelande

med en varning om att om åtgärden avbryts kan alla data som lästs av gå förlorade. Du

måste klicka på knappen READ DEVICE  (LÄS AV ENHET) för att starta om nedladdningen.

- Klicka på YES  (JA) för att avbryta.

- Klicka på NO  (NEJ) om du vill fortsätta att läsa av uppgifterna.

När systemet har avslutat avläsningen visas ett meddelande som bekräftar att avläsningen av

enheten är klar.

8 Klicka på OK.

- Se pumpens bruksanvisning om du vill starta den igen.
 
Om CareLink Pro inte kan hämta uppgifter från enheten, se Felsökning för mer information.
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6

Arbetsområdet Reports (Rapporter)

I CareLink Pro-programmet finns olika rapporter som hjälper dig att bättre hantera dina

patienters diabetesbehandling. Informationen i rapporterna är baserad på de data du får från

patientens enheter och hans eller hennes CareLink Personal-konto.

Rapporter kan genereras på skärmen, skickas direkt till en skrivare eller sparas som TIFF- eller

PDF-filer som du kan bifoga till en Electronic Medical Record (EMR). Du kan generera flera olika

slags rapporter genom en enda åtgärd.

De uppgifter som visas i rapporterna hämtas från patientens enheter, från hans eller hennes

CareLink Personal-konto, eller från båda.

OBSERVERA: Mer information om rapportkomponenterna och provrapporter finns med i
Report Reference Guide (Referensguide för rapporter). Du kan öppna referensguiden för
rapporter i CareLink Pro genom att gå till Help > View Report Reference Guide (PDF) (Hjälp

> Visa referensguiden för rapporter (PDF)) och sedan välja ditt språk.

Innan du börjar

Om du vill visa uppgifterna från en viss tidsperiod i en rapport måste du hämta uppgifterna om

den perioden från patientens enhet. Det kan även hända att patientens enhet måste anslutas till

datorn för att hämta aktuella uppgifter innan det går att skapa rapporter.
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Kontrollera uppgifterna under steget Verify Report Settings  (Bekräfta rapportinställningar) innan

du skapar en rapport. Där kan du finjustera en rapport så att du får fram just de patientuppgifter

som du önskar.

Skapa rapporter

I de följande avsnitten beskrivs vilka rapporter som finns tillgängliga för dig samt vilka åtgärder

du måste vidta för att generera dem.

Om du redan är bekant med rapporteringsprocessen och vet vilka rapporter du vill köra kan du

börja generera rapporter med en gång.

Öppna arbetsområdet Reports (Rapporter)

Klicka på patientfliken eller knappen Open Patient  (Öppna patient)  och dubbelklicka på

patientens namn.

Arbetsområdet Reports  (Rapporter) visas.

OBSERVERA: Klicka på SYNC DATA (SYNKRONISERA UPPGIFTER) för att säkerställa att du får

de senaste uppgifterna om enheten från patientens CareLink Personal-konto.

Välja rapporteringsperiod

1 Om du vill ändra hur lång tid rapporten/rapporterna ska omfatta klickar du på

nedrullningsmenyn Duration  (Tidsperiod) och väljer en tidslängd. (Den längsta tidsperioden

är 12 veckor.)

2 Från-och-med- och till-och-med-datum ställs in automatiskt om du inte väljer alternativet

custom date range  (anpassa datumintervall).

OBSERVERA: Om du väljer en tidsperiod som är längre än den längsta tillåtna visas ett

felmeddelande. Ändra tidslängden eller datumen.

Om du vill ställa in datumen själv ska du klicka på nedrullningsmenyn From (Från och med)

eller Through  (Till och med) och sedan välja månad, datum eller år.

Kalender

Kalenderområdet i arbetsområdet Reports (Rapporter) visar ett fönster på tre månader för

rapportering av information.
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De blå områdena motsvarar uppgifter från enheten. Det orangea området motsvarar

rapporteringsperioden som du har valt. Överlappningar mellan uppgifter från enheten och

rapporteringsperioden innebär att det finns uppgifter för några eller alla de

rapporteringsperioder som visas.

Kalenderområdet visar inledningsvis de senaste tre månaderna. Om du vill se andra månader ska

du klicka på piltangenterna  i början eller slutet av perioden.

Välja vilka uppgifter ska finnas med

1 Om patienten har en BS-mätare länkad till sin pump klickar du för att välja ett av följande

alternativ för rapportering av uppgifter från BS-mätaren:

- Från pumpen:  Fördelarna med det här alternativet är bland annat att du bara behöver

läsa av uppgifter från patientens pump, blodsockervärdena tidsstämplas av pumpen och

värdena kopplas direkt till  den bolusberäkning som använts. En nackdel är att om det

uppstår kommunikationsproblem mellan pumpen och den länkade mätaren så kan det

hända att blodsockervärdena för den perioden inte rapporteras. Dessutom kan det, om

patienten har en MiniMed Paradigm-pump äldre än 522/722, hända att de

blodsockervärden från Bolusguideberäkningarna som inte lett till  förändringar inte

rapporteras.

- Från länkad/länkade mätare:  Fördelen med det här alternativet är att alla värden som

sparats i den länkade mätaren rapporteras. Nackdelen är att du måste kontrollera att

pumpen och mätarens klockor var synkroniserade för att kunna samordna uppgifter från

mätaren och pumpen. Det kan alltså hända att du måste läsa av uppgifter från pumpen

och den länkade mätaren separat.

2 Markera rutan bredvid enheten om du vill att uppgifter från enheten ska tas med i

rapporterna.

Det går inte att lägga till enheter som undantogs vid valet under steg 1. Om du vill ändra

detta ska du välja det andra länkade mätaralternativet.

3 Avmarkera rutan bredvid enheten om du inte vill att uppgifter från den enheten ska tas med i

rapporterna.

Det går inte att avmarkera enheter som togs med vid valet under steg 1. Om du vill ändra

detta ska du välja det andra länkade mätaralternativet.
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Kontrollera uppgifter från enheten

1 Se efter i kalenderområdet i arbetsområdet Reports (Rapporter) om det orangea området

som motsvarar rapporteringsperioden överlappar de blå områdena som motsvarar uppgifter

från enheten.

2 Om det finns överlappningar för hela rapporteringsperioden finns det uppgifter för din(a)

rapport(er). I så fall kan du klicka på NEXT  (NÄSTA) och gå till Bekräfta rapportinställningarna

på sidan 39.

3 Om det inte finns någon överlappning, eller om överlappningen inte är tillräcklig, finns det

några alternativ:

- Justera rapporteringsperioden.

- Hämta ytterligare uppgifter från enheten.

Hämta ytterligare uppgifter från enheten

1 Klicka på knappen READ DEVICE  (AVLÄS ENHET) som hör till en viss enhet om du vill ha fler

uppgifter från denna enhet.

Fältet för avläsning av enheten visas.

VARNING: Avbryt eller slutför alla temporära basaldoser eller aktiva bolusar och radera
alla aktiva alarm. Pumpen stoppas under avläsningen. Kontrollera att pumpen startar

igen när avläsningen är klar.

OBS! Använd inte fjärrkontrollen då pumpen avläses. Om pumpbatteriet nästan är tomt

skickar pumpen inte några uppgifter till datorn. Byt ut batteriet om enhetens
statusskärm anger att batteriet är nästan tomt.

2 Kontrollera att uppgifterna i fältet Choose port (Välj port) är de rätta för den här enheten.

Om du vill ändra inställningen ska du klicka på nedrullningsmenyn för fältet och välja en

annan inställning.

3 Kontrollera att enheten är ansluten till din dator.

4 Om enheten är en pump kan du specificera hur många uppgifter du vill ha från den. Klicka på

nedrullningsmenyn Amount of Data  (Antal uppgifter) och välj en mängd.

OBSERVERA: Om du väljer All available data  (Alla tillgängliga uppgifter) läser systemet
av alla uppgifter i pumpen. Därmed skrivs alla dubbla uppgifter i systemet över.

5 Klicka på READ DEVICE  (AVLÄS ENHET). Läs noggrant det meddelande som visas eftersom

det ger specifika instruktioner för hur pumpen ska läsas av.

6 Följ instruktionerna och klicka på OK.
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Förloppsindikatorn för avläsning av enheten visas.

Du kan när som helst avbryta avläsningen genom att klicka på CANCEL (AVBRYT).

Ett bekräftelsemeddelande om att avläsningen är klar visas.

7 Klicka på OK.

Uppgifterna från enheten visas nu i uppgiftskalendern.

8 Klicka på NEXT  (NÄSTA) överst i arbetsområdet Reports  (Rapporter).

Steget Verify Report Settings (Bekräfta rapportinställningar) visas. Det gör att du kan

kontrollera att inställningarna för den här patienten är korrekta innan du kör rapporterna.

Bekräfta rapportinställningarna

1 Kontrollera att inställningarna för Glucose Target (Blodsockermål) är korrekta. Skriv in de

rätta värdena eller klicka på pilarna upp eller ned i fälten Low  (Låg) eller High (Hög) för att

höja respektive sänka värdena.

OBSERVERA: Markörer för mätaravläsningar (|| |) visas på tidslinjen för uppvaknings-
och läggningstid, samt på tidslinjen för måltidsmarkörer. Eftersom en del av

rapporterna bygger på uppgifter från angivna tidpunkter för måltider, uppvaknande
eller sänggående, är det viktigt att en patients markörer för Bolusguidehändelser och
mätaravläsningar grupperas på rätt sätt.

2 Klicka på ADD MEAL  (LÄGG TILL MÅLTID) för att lägga till en ny måltidsperiod. Klicka var som

helst på tidslinjen inom en av måltidsperioderna för att redigera en befintlig

måltidsperiod.

Fönstret för redigering av måltidsperioderna, som visas under tidslinjen, öppnas.

OBSERVERA: Du kan ha upp till fem måltidsperioder. Standardinställningen är frukost,
lunch och middag.

3 Skriv in text eller klicka på pilarna för att välja de inställningar du vill ha.

Om du bara vill använda dessa inställningar för den här måltiden ska du avmarkera rutan

bredvid Use these parameters for all of this patient's meals  (Använd dessa parametrar för

alla den här patientens måltider).

- Meal Name (Måltidsnamn):  det namn du vill ge måltidsperioden.

- Meal Time Period (Måltidsperiod): timmar då måltiden intas.

- Pre-Meal BG Target (Gränsvärde för blodsocker före måltid) (mmol/l eller mg/dl): de

lägsta och högsta gränsvärdena för patientens blodsockervärde före måltiden.

- Pre-Meal Analysis Period (Analysperiod före måltid): den tidsperiod som blodsockret

analyseras före en måltid. Glukosvärdena från den här tidsperioden används i detaljerade

rapportanalyser.

- Post-Meal BG Target (Gränsvärde för blodsocker efter måltid) (mmol/l eller mg/dl):
de lägsta och högsta gränsvärdena för patientens blodsockervärde efter måltiden.
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- Post-Meal Analysis Period (Analysperiod efter måltid):  den tidsperiod som

blodsockret analyseras efter en måltid. Glukosvärdena från den här tidsperioden används

i detaljerade rapportanalyser.

Du kan ändra längden på en befintlig period för måltider, uppvaknande och sänggående

genom att klicka på start- eller slutlägena och sedan dra och släppa dem längs

tidslinjen.

OBSERVERA: Måltidsperioder kan inte överlappa varandra, men start- och slutlinjerna
kan gränsa till varandra. Måltidsperioderna måste vara minst 60 minuter långa.

4 Om du vill använda de här måltidsinställningarna för patientens samtliga måltider ska du

markera rutan bredvid Use these parameters for all of this patient’s meals  (Använd dessa

parametrar för patientens samtliga måltider).

5 Klicka på SAVE (SPARA) efter att du har skapat eller redigerat en måltidsperiod.

6 Ta bort en måltidsperiod genom att klicka på DELETE MEAL (TA BORT MÅLTID). Klicka på

DELETE (TA BORT) när du uppmanas att bekräfta.

7 CareLink Pro kan komma ihåg dessa inställningar för patienten nästa gång du kör en rapport

för honom eller henne. Klicka på SAVE SETTINGS (SPARA INSTÄLLNINGAR) för att spara dem

för den här patienten.

8 Klicka på NEXT  (NÄSTA) överst i arbetsområdet Reports  (Rapporter).

I det här steget kan du välja och generera rapporter. Du kan välja en lista med rapporttyper

eller en datatabell som hjälper dig att välja att ta med eller utelämna uppgifterna från vissa

dagar i de dagliga detaljrapporterna.

OBSERVERA: Klicka på >>customize columns (anpassa kolumner) om du vill ändra hur

datatabellen visas. Se Preferenser för rapportgenerering på sidan 15.

9 Klicka på ikonen PRINT (SKRIV UT)  för att skriva ut innehållet på skärmen.

Välja rapporttyper och datum som ska omfattas

1 Markera rutan bredvid de rapporter du vill ska ingå i rapportuppsättningen.
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OBSERVERA: Kryssrutan för rapporten Dashboard/Episode Summary (Panel/
Episodsammanfattning) kan inte markeras om det finns sensor- och pumpdata för

mindre än fem dagar under den valda tidsperioden eller om uppgifterna från
tidsperioden kommer från en Guardian-monitor.

2 Om uppgifter har lästs av från en pump eller Guardian-monitor mer än en gång under

rapporteringsperioden kan det finnas flera snabböversikter över enhetsinställningarna:

a. Kontrollera att rutan bredvid Device Settings Snapshot (Snabböversikt över
enhetsinställningar) har markerats.

b. Klicka på pilen i datumfältet och välj datum och tid för en snabböversikt.

- Pump:  Välj en snabböversikt över patientens pump.

- Guardian:  Välj en snabböversikt över patientens Guardian-monitor.

Om något fält är skuggat finns det inga snabböversikter för rapporteringsperioden.

3 Bläddra igenom datatabellen för att granska den tillgängliga Daily Detail (Daglig detalj)-

rapportinformationen.

- Du kan sortera uppgifterna i varje kolumn. Klicka på kolumnrubriken för att sortera

uppgifterna i stigande ordning. Klicka på rubriken igen för att sortera uppgifterna i

fallande ordning.

OBSERVERA: Om det inte finns några uppgifter för ett visst datum går det inte att välja
det.

4 Markera rutan vid datatabellraderna för de datum du vill ha en Daily Detail-rapport över.

- Du kan ta med eller utelämna alla datum för Daily Detail-rapporter med ett enda klick

genom att markera eller avmarkera rutan över alla kryssrutor för datum i datatabellen.

Generera rapporter

1 När du har bekräftat valen för rapporter ska du klicka på GENERATE REPORTS (GENERERA

RAPPORTER) överst i arbetsområdet Reports  (Rapporter).

En lista med alternativ visas.

2 Välj hur du vill förhandsvisa, skriva ut eller spara rapporter.

Om du väljer Preview  (Förhandsvisning), visas fönstret Preview.

3 Klicka på pilarna för att navigera genom rapporter som består av flera sidor.

4 Klicka på någon av de andra knapparna överst i fönstret Preview  (Förhandsvisning) för att

spara eller skriva ut rapporterna.

5 Stäng fönstret genom att klicka på Stäng-knappen  i fönstrets övre högra hörn.
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Om rapporter

I detta avsnitt beskrivs de olika rapporterna. Mer information om rapportkomponenterna och

exempel på rapporter finns med i Report Reference Guide (Referensguide för rapporter). Du kan

komma åt Report Reference Guide (Referensguide för rapporter) genom CareLink Pro-

programvaran:

1 Välj Help > View Report Reference Guide (PDF) (Hjälp, Visa referensguiden för rapporter

(PDF)).

2 Välj ett språk för Report Reference Guide.
 
CareLink Pro-rapporterna har följande gemensamt:

• Rubrik  — I rubriken finns identifierande uppgifter som rapportens namn, patientens namn

och varifrån uppgifterna kommer.

• Kolhydrater och blodsockervärden  — Kolhydratenheterna visas kursivt och

blodsockervärdena visas i fetstil i diagram och tabeller.

• Helguppgifter  — Helgdagarna visas i fetstil så att det går lätt att hitta dem.

• Symbolförklaringar  — En lista med symboler visas längst ned på varje rapport. Även om

symbolerna används i flera olika rapporter så är symbolförklaringarna unika för varje

rapport.

Dashboard (Panel) och Episode Summary (Episodsammanfattning)

Dashboard (Panel) och Episode Summary (Episodsammanfattning) är en tvåsidig rapport som ger

en sammanfattning av patientens totala glykemiska kontroll under önskad tidsperiod. Första

sidan av rapporten utgör den så kallade Therapy Management Dashboard (Behandlingspanelen)

medan andra sidan är Episode Summary (Episodsammanfattningen). Nedan följer en beskrivning

av respektive sida.

Therapy Management Dashboard (Behandlingspanel)

På Therapy Management Dashboard (Behandlingspanelen) kan du se totalvärden för den

glykemiska kontrollen vid olika tidpunkter på dagen. Här visas överliggande sensorglukoskurvor

och insulindosering på en daglig kurva. Här visas också nattperioder och perioder kring måltider

så att du lättare ska kunna bedöma den glykemiska kontrollen före och efter måltid. Med hjälp av

dessa diagram kan du urskilja viktiga kliniska mönster som t.ex. hyperglykemi, hypoglykemi och

variationer i den glykemiska kontrollen. På Dashboard (Panelen) finns även en statistisk analys av

hypoglykemiska och hyperglykemiska mönster som återkommer vid bestämda tidpunkter under

dygnet.

Dessutom har du här möjlighet att se samband mellan glykemisk kontroll vid olika tider på

dygnet och viktiga behandlingsåtgärder, t.ex. basalprogram, insulinabsorption, insulinkänslighet

och kolhydratkvoter. Du behöver inte längre försöka fastställa sambanden mellan många olika

rapporter manuellt. Slutligen visar Dashboard (Panelen) sammanfattande statistik över pump- och

sensornanvändningen.
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Episode Summary (Episodsammanfattning)

Sidan Episode Summary (Episodsammanfattning) ger detaljerad information om hypoglykemiska

och hyperglykemiska episoder. Den visar de mest kritiska episoderna och frekvensen av händelser

som har samband med dessa och kan vara av intresse för ytterligare utredning. Om det är

tillämpligt räknas det i rapporten upp kända orsaker till hypoglykemiska och hyperglykemiska

avvikelser, med behandlingsförslag.

Slutligen visas på Episode Summary (Episodsammanfattning) observationer som rör beteende

eller följsamhet avseende användningen av insulinpump, CGM och BS-mätare. Dessa

observationer behöver inte ha samband med en episod.

Adherence (Respons)-rapport

Adherence (Respons)-rapporten visar uppgifter som beskriver hur insulinpumpar och sensorer

används och sådant beteende hos patienten som är av betydelse för behandlingen. Den besvarar

frågan ”Fanns det tillräckligt med uppgifter för att ge en riktig bild av hur patienten använder sin

insulinpump och sensor, om detta är relevant?”. Den besvarar också frågan ”Följer patienten

behandlingen enligt instruktion?” Rapporten visar även om du behöver prata med patienten om

hur han eller hon sköter sin diabetes.

Sensor and Meter Overview (Sensor- och mätaröversikt)-rapport

Sensor and Meter Overview (Sensor- och mätaröversikt)-rapporten ger en grafisk bild av

patientens dagliga blodsocker- och genomsnittsvärden från sensor och mätare, inklusive

uppgifter per timme över hela dygnet och hur värdena ligger i förhållande till patientens måltids-

och sömnmönster. Dessutom ingår statistik om patientens blodsockervärden och

insulindosering.

En analys av sensordata genereras på samma sätt som förstasidan i denna rapport om sensordata

finns tillgängliga. Om inga sensordata finns kommer uppgifterna från mätaren att genereras som

förstasida.

Rapportens sista sidor visar nivåerna dag för dag och kvaliteten på patientens glykemiska,

kolhydrat- och insulinkontroll. På varje sida visas hur kontrollen varierar dag för dag under hela

rapporteringsperioden med maximalt 14 dagar per sida.

Logbook (Loggbok)-rapport

Logbook (Loggbok)-rapporten visar mätarblodsocker samt kolhydrat- och insulindata för varje

dag under rapporteringsperioden. Resultat visas timme för timme och som dagliga medelvärden

och totalsummor. Varje sida innehåller upp till 14 dagar. Om rapporteringsperioden överstiger 14

dagar genereras extra sidor.

Device Settings Snapshot (Snabböversikt över enhetsinställningar)

Rapporten Device Settings Snapshot (Snabböversikt över enhetsinställningar) ger en

snabböversikt över inställningarna för patientens pump eller Guardian REAL-Time-monitor vid ett

specifikt datum och en specifik tidpunkt. Det kan hjälpa dig att förstå andra rapporter eller helt

enkelt utgöra en dokumentation över patientens inställningar.
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Pump- eller monitorinställningarna registreras bara när enheten läses av. Om enheten inte

avlästes under rapporteringsperioden finns inga inställningar tillgängliga.

Daily Detail (Daglig detalj)-rapport

Rapporten Daily Detail (Daglig detalj) visar glukosdata, kolhydratmängder samt patientens

insulinanvändning under en vald dag. En separat rapport genereras för varje dag som valts i

datatabellen.

Rapporten Daily Detail (Daglig detalj) ger en detaljerad översikt över alla dagar som valts. Den gör

att du kan fokusera på en viss dag om något av vikt för patientens behandling kan ha

inträffat.

Exportera data

Du kan exportera data från enheten som hämtats och lagrats av CareLink Pro. Den ger dig alla

uppgifter från patientens enhet så att du kan använda dem för statistiken eller för att skapa

specialrapporter eller diagram. Filen (.csv) kan importeras till Microsoft Excel eller till vissa kliniska

statistikprogram där uppgifterna kan bearbetas ytterligare.

Filen (.csv) innehåller uppgifter om enhetens aktiviteter. Den listar till exempel registrerade

mätarvärden, att pumpen fått ett värde från mätaren eller ändringar av basaldosen.

OBSERVERA: Detta är en avancerad funktion som kräver att du känner till rådata från
enheten. Dessutom måste du vara bekant med den programvara till vilken du importerar

filen (.csv).

Följ dessa instruktioner för att använda exportfunktionen i CareLink Pro:

1 Klicka på patientfliken eller knappen Open Patient  (Öppna patient)  och dubbelklicka på

patientens namn.

2 Kontrollera att arbetsområdet Reports  (Rapporter) visas.

3 Ställ in datum och rapportlängd i fälten Duration (Varaktighet) eller From/Through  (Från-

och-med/Till-och-med).

Den längsta period du kan välja är 12 veckor.

4 Klicka på länken export selected data (exportera valda uppgifter).

Dialogrutan Export Data to CSV File  (Exportera data till  CSV-fil) visas.

5 Navigera till  platsen där du vill spara filen (.csv) på datorn. Om du vill ändra filens namn ska

du skriva in det i rutan File name  (Filnamn).

6 Klicka på SAVE (SPARA).

OBSERVERA: Mer information om de uppgifter som visas i CSV-filer finns i bilagan för
CSV-data.

Nu har filen (.csv) sparats på datorn, där du valt att den ska sparas. Om du vill kan du välja att

importera den till ett program som stöder den här filtypen.
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Systemadministration

Det är väldigt viktigt att du regelbundet gör en säkerhetskopia av CareLink Pro-databasen. I

databasen sparas alla systemuppgifter som samlats i patientens journaler, inklusive information

om profilen, uppgifter som härletts från enheten och rapportinställningar.

Det är också viktigt att du har den senaste versionen av CareLink Pro. Uppdaterade versioner

kommer regelbundet och kan innehålla viktiga förbättringar. Du kan antingen välja att leta efter

uppdateringar eller få ett meddelande om när de är tillgängliga.

Programvaruuppdateringar 

Vid olika tillfällen kommer programvaran till  CareLink Pro att uppdateras. Gör så här när du får

ett meddelande om att det finns en uppdatering.

OBSERVERA: Gör en säkerhetskopia av databasen innan programvaran uppdateras. Se

Säkerhetskopiera databasen på sidan 46.

1 Kontrollera att din dator har en aktiv Internet-anslutning.

2 Meddelandet CareLink Pro Update visas när det finns en uppdatering av CareLink Pro. Du kan

då välja att ladda hem uppdateringen.

3 Klicka på DOWNLOAD  (LADDA HEM). (Om du klickar på CANCEL (AVBRYT) stängs

meddelandet om uppdatering. Du kan ladda hem uppdateringen vid ett senare tillfälle.)

Ett varningsmeddelande visas som rekommenderar dig att ta en säkerhetskopia på din

databas.

4 Klicka på YES  (JA) för att skapa en säkerhetskopia av databasen (se Säkerhetskopiera

databasen på sidan 46). Klicka på NO (NEJ) om du redan har gjort en säkerhetskopia.

Ett meddelande visas som bekräftar att den nya versionen av CareLink Pro har laddats ner.

5 Klicka på YES  (JA) för att stänga och öppna programvaran på nytt om du vill börja använda

den senaste versionen av CareLink Pro. Klicka på NO (NEJ) om du föredrar att starta om

CareLink Pro vid ett senare tillfälle.
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Avstängning av automatiska uppdateringar

Gör så här om du inte vill få automatiska meddelanden om uppdateringar av CareLink Pro:

1 Välj Tools > Options (Verktyg > Alternativ).

2 Klicka på fliken General (Allmänt).

3 Avmarkera rutan bredvid Automatically check for software updates  (Sök automatiskt efter

programuppdateringar) i avsnittet Communications (Kommunikationer).

Manuell kontroll av uppdateringar

Du kan när som helst manuellt kontrollera om det finns några CareLink Pro-uppdateringar.

OBSERVERA: Gör en säkerhetskopia av databasen innan programvaran uppdateras. Se

Säkerhetskopiera databasen på sidan 46.

1 Kontrollera att din dator har en aktiv Internet-anslutning.

2 Välj Tools > Check for Software Updates (Verktyg > Sök efter programuppdateringar).

3 Om det inte finns några uppdateringar tillgängliga visas ett meddelande om detta. Om det

finns en uppdatering visas ett meddelande om CareLink Pro-uppdatering.

4 Följ stegen i avsnittet Programvaruuppdateringar på sidan 45.

Säkerhetskopiera och återställa databasen

Det är en bra idé att ha ett regelbundet schema för säkerhetskopiering av databasen. På så sätt är

du säker på att det görs regelbundet och därmed minskar risken för att uppgifter går

förlorade.

Om du säkerhetskopierar eller återställer databasen visar systemet ett varningsmeddelande om

det är någon som använder programvaran på en annan dator.

Säkerhetskopiera databasen

Gör så här för att göra en säkerhetskopia av databasen.

1 Kontrollera att alla patientjournaler är stängda.

2 Välj Tools > Backup Database (Verktyg, Säkerhetskopiera databas).

OBSERVERA: Säkerhetskopior av databasen kan sparas på en nätverksenhet eller på ett
flyttbart lagringsmedium (DVD, CD eller USB-minne).

3 Navigera till platsen där du vill spara säkerhetskopian på datorn. Om du vill ändra filens namn

ska du skriva in det i rutan File name  (Filnamn).

4 Klicka på Save (Spara). En förloppsindikator visas medan databasen sparas.

Ett meddelande visas när säkerhetskopieringen är klar.

5 Klicka på OK för att stänga meddelandet.
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Återställa en databas

Det kan hända att databasen måste bytas ut om den inte längre kan öppnas eller användas.

Ju nyare säkerhetskopian är, desto färre uppgifter går förlorade om du måste ersätta

databasen.

OBS! När du återställer databasen med en säkerhetskopia går alla uppgifter som skapats i
den nuvarande databasen efter den valda säkerhetskopian förlorade.

Gör så här för att välja en säkerhetskopia som ska ersätta den aktuella databasen.

1 Kontrollera att alla patientjournaler är stängda.

2 Välj Tools > Restore Database  (Verktyg > Återställ databas).

3 Välj den säkerhetskopia du vill använda för att ersätta den aktuella databasen (oftast den

senaste).

4 Klicka på Open  (Öppna). Ett varningsmeddelande visas för att påminna dig om att alla

uppgifter kan gå förlorade om du fortsätter med återställandet av databasen.

5 Klicka på OK för att fortsätta. En förloppsindikator visas medan databasen återställs.

Ett meddelande visas när databasen är återställd.

6 Klicka på OK för att stänga meddelandet.

Om systemet inte är tillgängligt

Om du försöker starta systemet medan en annan användare säkerhetskopierar eller utför en

återställning, visas ett meddelande om att systemet inte är tillgängligt. Du kan inte använda

systemet förrän uppgiften är klar.

Gör något av följande:

• Vänta tills processen är färdig och systemet är tillgängligt igen.

• Klicka på CANCEL  (AVBRYT) för att avsluta och försöka igen senare.
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Felsökning

Det här avsnittet hjälper dig att lösa problem som kan uppstå när du använder programvaran

CareLink Pro. Det innehåller också instruktioner för hur du avinstallerar CareLink Pro, ifall det

skulle behövas.

Allmänna fel

Om du försöker hämta en uppdatering av programvaran från Internet kan det hända att du får

ett meddelande om att du inte är auktoriserad att göra det. Du måste ha

administratörsbehörighet för att få hämta uppdateringar av CareLink Pro.

1 Stäng CareLink Pro och starta om datorn.

2 Be någon med administratörsstatus logga in på datorn.

3 Följ instruktionerna i avsnittet Programvaruuppdateringar på sidan 45.

Inte ansluten till databasen

Ett felmeddelande som anger att du inte är ansluten till databasen innebär något av följande:

• Databasen har flyttats. Databasen måste vara på samma plats som valdes då programvaran

CareLink Pro installerades. Om den har flyttats måste den flyttas tillbaka till den plats som

valdes under installationen.

• Du är inte ansluten till den nätverksenhet där databasen ligger. Om databasen ligger på en

nätverksenhet kan det hända att nätverket har vissa problem som gör att du inte kan komma

åt stationen. Du är inte ansluten till den nätverksenhet där databasen ligger.

Glömt klinikens lösenord till CareLink Pro

Om ingen kommer ihåg det lösenord som kliniken använder för att logga in till  CareLink Pro

måste CareLink Pro installeras på nytt och en ny databas skapas. När du har ominstallerat

programvaran kommer du inte åt någon patientinformation i den tidigare databasen. Förvara

lösenordet som du skapade under den nya installationen på en säker plats så att inga framtida

uppgifter går förlorade.
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Fel vid avläsning av enheten

Fel Förklaring

Den seriella port som valdes kan inte öppnas. Det kan
hända att en annan handling utförs på den porten.
Vänta tills porten blir ledig eller välj en annan port.

Bekräfta att kommunikationsporten inte används av
något annat program eller välj en annan port. Försök
att starta om datorn som du använder och försök
sedan att läsa av enheten igen. Det kan vara något fel
på den maskinvara (t.ex. kabeln) som anslutits till
porten eller ett fel på själva porten. Anslut
maskinvaran till en annan port och försök läsa av
enheten igen, för att avgöra om det var problemet.

Auto Detect hittade inte enheten på någon tillgänglig
port. Kontrollera kabelanslutningen, enhetens batteri
och status och försök igen, eller försök specificera en
seriell port.

Kontrollera anslutningen mellan kabeln och datorn
samt att batteriets status är OK. Om dessa är bra,
pröva att specificera den seriella port på datorn som
kabeln anslutits till, i stället för att välja Auto Detect.

Enheten hittas inte i den seriella port som valts.
Kontrollera kabelanslutningen, enhetens batteri och
status och försök igen. Pröva med att specificera en
annan port eller pröva med Auto Detect.

Kontrollera anslutningen mellan kabeln och datorn
samt att batteriets status är OK. Om dessa är bra,
pröva antingen att välja en annan seriell port på
datorn eller välj alternativet Auto Detect.

Kan inte kommunicera med enheten. Kontrollera att
du har satt i och valt rätt enhet, kontrollera
kabelanslutningen, enhetens batteri och status och
försök igen.

Kontrollera alla inställningar som valts för avläsning av
enheten, inklusive enhetens namn, serienummer och
typ av anslutning. Kontrollera även att enheten,
kablarna och datorn är anslutna på rätt sätt.
Kontrollera att enhetens batteri- och alarmstatus är
OK. Försök läsa av igen.

Oväntad respons... försöker igen (n%)
Ett oväntat värde lästes av från enheten. Systemet
försöker återuppta kommunikationen tills det att du
avbryter eller tills kommunikationen lyckas.

Länkenheten hittades, men enheten (<serienummer>)
reagerar inte. Bekräfta enhetens serienummer, placera
enheten närmare länkenheten för minimal
signalstörning, kontrollera enhetens batteri och status.

Kontrollera att rätt serienummer angivits. Om inte,
skriv in rätt serienummer. Om serienumret är korrekt,
pröva med att placera länkenheten närmare
kommunikationsenheten. Flytta länkenheten och
kommunikationsenheten bort från eventuella
störningar (t.ex. andra RF-enheter). Kontrollera
enhetens batteriladdning och, om du överför data från
en insulinpump, kontrollera även pumpens
doseringsstatus.

Pumpen doserar en temporär basaldos. Avbryt den
temporära basalen eller vänta tills den är slutförd och
försök sedan på nytt.

Den pump du försöker läsa av doserar en temporär
basaldos. Vänta antingen med att avläsa pumpen tills
den temporära basaldosen är avslutad eller avbryt den
temporära basaldosen och läs sedan av pumpen.

Enheten har aktiva fel eller alarm. Radera alarmen och
försök på nytt.

Det finns aktiva alarm på pumpen som gör att den
inte kan läsas av. Läs igenom alarminstruktionerna och
radera alarmet. Radera alarmet och försök läsa av
pumpen på nytt.

Pumpen doserar en bolus. Avbryt bolusen eller vänta
tills den är slutförd och försök sedan på nytt.

Den pump du försöker läsa av doserar en bolus. Vänta
antingen med att avläsa pumpen tills bolusen är
avslutad eller avbryt bolusen och läs sedan av
pumpen.

Enheten skickar ogiltiga uppgifter; alla avlästa
uppgifter kasseras.

Kontakta Medtronic-representanten (se Hjälp på
sidan 2).
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Fel vid skapande av rapporter

Flera uppgifter för samma datum

Om det finns flera uppgifter för samma datum och tid för samma enhet så betraktar systemet det

som en konflikt som inte kan lösas. Rapporter som skapas med dessa uppgifter utelämnar den del

av uppgifterna som överlappar varandra.

Du kan försöka anpassa rapporteringsperioden så att de överlappande uppgifterna utelämnas.

Eller så kan du ta bort enheten från systemet och sedan lägga till den igen så att de tidigare

avläsningarna raderas.

Systemet kommer att ignorera uppgifterna

Om tiden på en enhet har ändrats så att det ger överlappningar eller utelämnade uppgifter på tre

timmar eller mer tar inte systemet med dessa uppgifter då rapporterna skapas.

Säkerhetskopierings- och återställningsfel

Databasen kan inte låsas

Det innebär att du använder systemet i en miljö med flera användare och att andra användare var

inloggade. Systemet tillåter inte en säkerhetskopiering av databasen samtidigt som andra

användare kan utföra uppgifter som kan påverka databasen. Du kan göra en säkerhetskopia av

databasen när alla andra användare har slutat att använda CareLink Pro.

Säkerhetskopieringen eller återställandet av databasen slutförs inte

Andra användare kan inte logga in och säkerhetskopieringen eller återställandet kan inte

slutföras. Kontakta Medtronic-representanten (se Hjälp på sidan 2).

Återställandet av databasen misslyckas

Det är något fel på den säkerhetskopia av databasen som du försöker använda för återställandet.

Försök återställa med en annan säkerhetskopia.

Avinstallera programvaran

Gör så här för att avinstallera CareLink Pro:

1 Öppna Kontrollpanelen från Windows Startmeny.

2 Välj Add or Remove Programs  (Lägg till eller ta bort program). Fönstret för att lägga till  eller

ta bort program visas.

3 Bläddra ner till Medtronic CareLink Pro  och klicka på detta alternativ.

4 Klicka på Remove (Ta bort). Installationsguiden visas.

5 Klicka på Next  (Nästa). Ett meddelande visas som ber dig bekräfta att du vill ta bort

programmet.
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6 Klicka på Yes (Ja). Avinstallationsprogrammet körs och tar bort programmet och alla dess filer

från din dator. När det är klart visas ett meddelande på skärmen som bekräftar

avinstallationen.

7 Klicka på Finish  (Slutför).
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9

Symbolförteckning

Ikonerna och symbolerna på förpackningsetiketten och utrustningen beskrivs i följande tabell:

Beskrivning Ikon

En per behållare/förpackning (1X)

CD medföljer

Se bruksanvisningen

Tillverkningsdatum (År)

Referensnummer

Conformité Européene (Europeisk standard). Denna
symbol betyder att enheten uppfyller direktiv
93/42/EEG om medicintekniska produkter.
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A

CSV-data

När du exporterar rapportuppgifter från CareLink Pro exporteras uppgifterna till  en CSV-fil. Denna

fil kan sedan importeras till ett kalkylprogram, t.ex. Microsoft Excel. För en komplett lista över de

data som kan finnas i en CSV-fil, se kolumndefinitionerna för CSV-filer.

CSV-filen innehåller patientens namn, ID och rapporteringsperioden, och identifierar varje enhet

som ingår i rapporten.

Definition av kolumnerna

Kolumnrubrik Definition

Index Den ordning i vilken uppgifterna registrerades i
enheten.

Date (Datum) Den ordning i vilken datumen registrerades i enheten.

Time (Tid) Den ordning i vilken tiden registrerades i enheten.

New Device Time (Ny tid i enheten) Det nya datumet och den nya tiden om det har
ändrats i enheten.

BS-värde (mmol/l eller mg/dl)

Det blodsockervärde som registrerats av mätaren,
Guardian eller pumpen. Om uppgifterna kommer från
en pump eller Guardian, är värdena i kolumnen
manuella BS-värden och BS-värden från en Link-
mätare.

Linked BG Meter ID (ID för länkad BS-mätare) Serienumret på den mätare som skickar ett visst
blodsockervärde till enheten.

Basal Rate (U/h) (Basaldos (E/tim)) Den aktiva basalinsulindosen i enheter per timme.

Temp Basal Amount (Temp basalmängd) Om en temporär basaldos användes i pumpen anger
det här värdet temporär basalmängd.

Temp Basal Type (Temp basaltyp) Typ av temporär basaljustering (insulindos eller
procent av basaldosen).

Temp Basal Duration (m) (Temp basal varaktighet (m)) Tidslängden i minuter för den temporära
basalinsulindoseringen (se typen ovan).

Bolus Type (Bolustyp) Doseringstyp för bolusinsulin [normal, förlängd,
dubbel (normal del) eller dubbel (förlängd del)].

Bolus Volume Selected (U) (Vald bolusvolym (E)) Antalet insulinenheter som valts att doseras under
bolusinsulindosering.
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Kolumnrubrik Definition

Bolus Volume Delivered (U) (Doserad bolusvolym (E)) Antalet insulinenheter som verkligen doseras under
bolusinsulindosering.

Programmed Bolus Duration (h) (Programmerad
bolusvaraktighet (tim))

Varaktighet för förlängd bolus eller den förlängda
delen av en dubbel bolus.

Prime Type (Primetyp)

Manuell eller fast. Manuell används omedelbart efter
en återställning, för att fylla infusionssetet med insulin
innan det sätts in. Fast används efter att infusionssetet
satts in för att fylla den mjuka kanylen med insulin
efter att mandrängen har tagits ut.

Prime Volume Delivered (U) (Doserad primevolym (E)) Antalet insulinenheter som verkligen doseras för
primen.

Alarm Namnet på det alarm som gått.

Stoppa Identifierar pumpens stoppstatus.

Rewind (Återställ pump) Datum och tid för återställning av enheten.

BWZ Estimate (U) (Bolusguide beräkning (E)) En uppskattning av bolusinsulinet om det beräknats
med funktionen bolusguide på Paradigm-pumpen.

BWZ Target High BG (mmol/L or mg/dL) (Bolusguide
högt BS (mmol/l eller mg/dl))

Inställningen för det högre gränsvärdet för blodsocker,
som används av bolusguidefunktionen.

BWZ Target Low BG (mmol/L or mg/dL) (Bolusguide
lågt BS (mmol/l eller mg/dl))

Inställningen för det lägre gränsvärdet för blodsocker,
som används av funktionen Bolusguide.

BWZ Carb Ratio (Bolusguide kolh.kvot)

Inställning för insulin-kolhydratkvoten. Om enheten
gram används är denna kvot mängden kolhydrater i
gram som täcks av en enhet insulin. Om enheten
utbyten används är denna kvot det antal
insulinenheter som används för att täcka ett
kolhydratutbyte.

BWZ Insulin Sensitivity (Bolusguidens insulinkänslighet)
Inställningen för insulinkänslighet. Insulinkänsligheten
är den mängd blodsockervärdet minskas med av en
enhet insulin. Detta används av bolusguidefunktionen.

BWZ Carb Input (Bolusguide kolh.kons.) Mängd kolhydrater som anges i bolusguiden och
används för att beräkna bolus.

BWZ BG Input (mmol/L or mg/dL) (Bolusguide BS-
inmatn. (mmol/l eller mg/dl))

Blodsockervärde som anges i bolusguiden och
används för att beräkna bolus.

BWZ Correction Estimate (U) (Bolusguide
korrektionsberäkning (E))

Antal enheter bolusinsulin som ska ges för att
korrigera blodsockervärdet, beräknat av funktionen
Bolusguide.

BWZ Food Estimate (U) (Bolusguide matberäkning (E))
Det beräknade antalet enheter bolusinsulin för att
täcka det förväntade kolhydratintaget, beräknat av
funktionen Bolusguide.

BWZ Active Insulin (U) (Bolusguide aktivt insulin (E))

Mängden aktivt insulin som beräknats ska finnas kvar i
kroppen från tidigare bolusinsulindoser när
bolusmängden ska beräknas med funktionen
Bolusguide.

Sensor Calibration BG (mmol/L or mg/dL)
(Sensorkalibrering BS (mmol/l eller mg/dl))

Det BS-värde som används för kalibrering av sensorn i
mmol/l eller mg/dl.

Sensorglukos (mmol/l eller mg/dl) Sensorglukosvärdet.

ISIG value (ISIG-värde) Ingångssignaler (ISIG), läses från sensorn och mäts i
nanoampere (nA).

Mer om CSV-filer som exporteras av CareLink Pro

Rubriken överst i en CSV-fil innehåller följande information:
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• patientens namn

• en lista med valda enheter och deras serienummer

• valda datum
 
Varje block med kolumner har en titel som innehåller det följande:

• namnet på den enhet uppgifterna gäller för

• serienumret på den enheten

Om uppgifterna inte visas som förväntat

Det är flera olika faktorer som kan göra att CSV-uppgifterna visas på ett annat sätt än

förväntat.

• Ändringar av datum eller tid på enheten kan ändra sekvensen eller ge registreringar utanför

det valda datumområdet.

• Om det finns en stor lucka mellan avläsningarna av enheten kan det hända att uppgifterna

för den enheten visas i flera block.
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Ordlista

A1C - Glykosylerat hemoglobin

A1C-test - Hemoglobin A1C-test, som används för att tolka blodsockervärden under en tidsperiod.

Arean under kurvan (AUK) - Visar omfattningen av höga och låga avvikelser, fastställda enligt de
förinställda värdena. Avvikande data anger hur ofta värdena var för höga eller för låga. AUK
visar händelsernas omfattning genom att visa hur långt utanför områdena de låg och under hur
lång tid.

Basaldos - Pumpinställning som ger löpande insulininfusion för att hålla blodsockret stabilt
mellan måltiderna och under natten. Basalinsulinet efterliknar bukspottkörtelns
insulindosering, vilket uppfyller kroppens hela behov av insulin utanför måltiderna.

Basalinsulin - En kontinuerlig mängd insulin per timme som doseras automatiskt av
insulinpumpen, grundad på förprogrammerade profiler för personliga doser som ställts in i
pumpen. Pumpen doserar en daglig mängd insulin som normalt sett täcker bakgrundsbehovet
av insulin under perioder med fasta (t.ex. nattetid och mellan måltiderna).

Basalprofil - En basaldos med en start- och en stopptid. För att få bättre glukoskontroll kan
användaren programmera in flera olika profiler i sin pump under en 24-timmarsperiod, var och
en med sin egen basaldos.

Basalprogram - Användaren kan programmera upp till tre olika basalprogram i sin pump för
dosering av basalinsulin: Standard, A och B. I varje program kan upp till 48 basaldoser ställas in.

Bolusinsulin - En dos insulin som doseras för att täcka en förväntad höjning av blodsockret (som
t.ex. höjningen efter en måltid eller ett mellanmål) eller för att sänka ett högt blodsocker ner till
målvärdet.

BS - Förkortning för blodsocker.

CareLink® Personal - En onlinetjänst som kan hantera diabetesuppgifter via Internet.

ComLink - En radiofrekvensenhet (FR) med sändare och mottagare som används för att hämta
uppgifter från Paradigm-pumpen till datorn.

Com-Station - En enhet som används för att hämta uppgifter från pumpen MiniMed 508 och
vidarebefordra uppgifter från andra tillverkares mätare till datorn.

Dubbel bolus (Dual Wave®) - En kombination av normal bolus som doseras omedelbart och
därefter följs av en förlängd bolus. Förlängd bolus doserar jämnt under en period.

Expressbolus - En tillsatsmetod för valfri bolustyp som använder sig av pumpens express bolus-
knapp.

Förlängd del - Den andra delen i en dubbel bolus. Den förlängda delen doserar jämnt över en
period sedan NU-delen doserats.
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Förlängd (Square Wave®) bolus - Bolus som avges jämnt under en specificerad tidsperiod (30
minuter till 8 timmar).

Genomsnittlig absolut differens i % (MAD %) - Visar noggrannheten hos sensorkalibrering
jämfört med BS-mätaravläsningar. Ju lägre denna siffra är, desto högre blir
kalibreringsnoggrannheten. MAD % beräknas genom att differensen mellan närliggande par av
sensorglukos- och BS-mätarvärden delas med BS-mätarvärdet. Därefter beräknas ett
genomsnitt för samtliga värdepar.

HbA1c - Glykosylerat hemoglobin.

HbA1C-test - Hemoglobin A1C-test, som används för att tolka blodsockerkontrollen eller
genomsnittet av värdena under en period på 2-3 månader.

Hyperglykemisk - Förhöjt blodsocker som upptäcks vid övervakningen av blodsockervärdena,
med eller utan något eller alla av de följande symptomen: illamående, kräkningar, suddig syn,
huvudvärk, orolig mage, att kissa ofta och stora mängder samt apati.

Hypoglykemisk - Lågt blodsocker som upptäcks vid övervakningen av blodsockervärdena, med
eller utan något eller alla av de följande symptomen: extrem hunger, skakningar eller
darrningar, svettning, ögonflimmer, yrsel, huvudvärk, sluddrigt tal, plötsliga humörsvängningar
eller personlighetsförändringar.

Högt BS - Pumpen utlöser ett alarm om sensorn indikerar att användarens sensorblodsocker är lika
med eller över detta värde. Du kan aktivera eller inaktivera den här funktionen som du vill.

Infusionsset - Den apparat som används för att föra in och säkra en kanyl under huden och
transportera insulin till insticksstället genom slangar från pumpen.

Insulinkoncentration - Styrkan eller typen av insulin som läkaren skrivit ut åt användaren. Detta
påverkar den insulindos som pumpen doserar. Om användarens insulinkoncentration ändras
måste basalprofilerna och de högsta basal- och bolusdoserna programmeras om i pumpen.

Insulinkänslighet - Hur mycket i mg/dl (eller mmol/l) din blodsockernivå (BS-nivå) förändras av en
enhet insulin. (Bolusguidedata.)

ISIG - Sensorvärden som anger om sändarens elektronik i ett sensorförstärkt system fungerar
korrekt. Ring för produktassistans om du ser ett ISIG-värde som ligger under 24,00 nA eller över
29,00 nA. Det kan vara dags att byta ut din sändare.

Kalibreringspåminnelse - Pumpen utlöser automatiskt varningen "BS-VRD KL. TT:MM" var tolfte
timme för att signalera att det aktuella kalibreringsvärdet inte gäller längre.
Kalpåminnelsevärdet anger tidsperioden tills dess att det aktuella kalibreringsvärdet löper ut
och användaren vill bli påmind om att kalibrera. Om kalibreringspåminnelsen exempelvis ställts
in på två timmar så avges varningen "BS-VRD KL. TT:MM" två timmar innan kalibrering krävs.

Ketontest - Ketoner är en avfallsprodukt som produceras när kroppen tvingas att förbränna
kroppsfett i stället för blodsocker för att få energi. Det kan vara ett tecken på insulinbrist i
kroppen. Ketontestet mäter ketonkoncentrationen i blodet eller urinen.

KH - Kolhydrater

Kolh. kvot (Kolhydratkvot) - Den mängd kolhydrater som täcks av en enhet insulin. (Se även
utbyteskvot).

Kolhydratenheter - Matintag med Bolusguide. Förs in som (kolhydrat) gram eller utbyten.

Korrektionsbolus - Den mängd insulin som behövs för att få ned den höga blodsockernivån till
målvärdet.

Korrektionsbolusfaktor - Hur mycket 1,0 enhet insulin sänker blodsockret. Denna faktor används
för att beräkna en korrektionsbolusmängd när blodsockret är högt. (BS-nivå) - (BS-mål) = X. X ÷
(korrektionsbolusfaktor) = korrektionsbolusmängd

Ljudbolus - Pumpen kan programmeras så att användarna hör en signal när de väljer en
bolusinsulinmängd (0,5 eller 1,0 enheter) som ska doseras. Den här funktionen är praktisk i
lägen där det är svårt att se knapparna på pumpen.

Ljudbolus (Easy Bolus™) - Doseringsmetod för en normal bolus som använder knappen
Ljudbolus på pumpen.
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Lågt BS - Pumpen utlöser ett alarm om sensorn indikerar att användarens sensorblodsocker är lika
med eller under detta värde. Du kan aktivera eller inaktivera den här funktionen som du vill.

Länk
(1) Att slå på och ställa in det mätaralternativ som gör det möjligt för pumpen att ta emot BS-
värden från en mätare som kommunicerar med din pump.
(2) Termen används även i det här systemet som hänvisning till hypertextlänkar. Om du klickar
på en hypertextlänk kommer du till ett annat ställe i systemet eller till en annan hemsida.

Manuell bolus - Valfritt alternativ i BOLUSMENYN när bolusguiden är aktiv. En metod för att
programmera en bolus utan bolusguiden.

Max basalinsulin - Den maximala mängd basalinsulin som pumpen är inställd på att dosera per
timme. (ställs in av användaren)

Max bolus - Den maximala mängd bolusinsulin som pumpen är inställd på att dosera per timme.
(ställs in av användaren)

Måltidsbolus - En dos insulin som doseras för att täcka den förväntade höjningen av blodsockret
efter en måltid.

Mätaralternativ - Funktion som gör att pumpen tar emot BS-värden från en länkad
blodsockermätare.

Mätare - En medicinsk utrustning som mäter den ungefärliga glukosnivån i blodet. En liten droppe
blod läggs på en engångstestremsa. Mätaren läser av värdet och beräknar blodsockernivån.
Mätaren visar sedan värdet i mmol/l eller mg/dl.

Normal bolus - En omedelbar dosering av en specificerad mängd insulin.

Program, standard - Din normala basaldos för dina dagliga aktiviteter. När programfunktionen är
avstängd, använder pumpen ditt standard(basal)program.

Programfunktion - En pumpfunktion som låter dig programmera valfria basaler (Program A,
Program B) som uppfyller insulinbehov för aktiviteter eller blodsockermönster som inte är en
del av dina dagliga rutiner, men som ändå förekommer i din livssituation. Det kan t.ex. vara en
idrottsaktivitet som du utför en gång per vecka, ändrade sovvanor under veckosluten eller
hormonförändringar under menstruationen.

RF - Radiofrekvens (RF)

Steg - Inställda antal enheter insulin per knapptryckning vid Ljudbolus-dosering.

Stoppa - En funktion hos pumpen som stoppar all insulindosering. Alla pågående bolus- och/eller
primedoser avbryts. Basaldoseringen avbryts temporärt tills den återstartas.

Sändar-ID - Serienummer på den sändare som för tillfället används.

Temp - Temporär.

Temporär basal - Temporär engångsdosering av basalinsulin med specificerad mängd och
varaktighet. Används för att fylla insulinbehov för speciella aktiviteter och situationer som inte
tillhör de normala, dagliga rutinerna.

Utbyteskvot - Den mängd insulin som behövs för att täcka ett (1) kolhydratutbyte. (Se även
kolhydratkvot).

Varning för låg reservoarvolym - Programmerbar varning, som antingen uppmärksammar dig
på att ett specificerat antal enheter finns kvar i pumpreservoaren eller att en specificerad tid
återstår innan reservoaren är tom.

Överföra - Processen att föra över uppgifter från pumpen eller mätaren till CareLink® Personal-
servern.
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